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Introduction

QuarkXPress 6.0 lets you create rich, expressive Web and print output in an

enhanced, intuitive work environment. 

Layout spaces, new to QuarkXPress 6.0, allow you to easily repurpose content and

move content between layouts. You can even synchronize text between layouts, sav-

ing you time and effort. 

Enhancements to Web tools let you create even more comprehensive, interactive

Web pages. For instance, you can create two-position rollovers and cascading

menus, as well as CSS font families. The Hyperlinks palette has also been

redesigned to make it easier to use, and you can use hyperlinks in print-optimized

and Web-optimized layouts.

Working with items on-screen just got easier — you can view full-resolution pre-

views of graphics, and the Multiple Undo feature gives you even greater flexibility

in creating layouts. 

Layers and tables functionality has also been improved to allow you to suppress lay-

ers at print time, link text cells in a table, apply clipping settings to a picture in a

table cell, and more.

Important printing enhancements, including support for As Is composite color and

support for PostScript Level 3 features such as SmoothShading, let you create vivid,

detailed printed output. 

Because QuarkXPress 6.0 supports Mac OS X and Windows XP, the interface has

changed slightly, but don’t let that throw you — these changes just mean that your

work environment is even more intuitive and well-organized than before.

QuarkXPress 6.0 still gives you the precision and control you rely on to create mag-

nificent, powerful output.
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Chapter 1: Layout Spaces

Layout spaces let you create one project that encompasses multiple media publishing

possibilities. Perhaps you are designing a brochure that you will produce using offset

printing, and you also plan to repurpose the brochure to post it on your Web site.

You want the same basic content for each of these products, but you must customize

each layout to accommodate its medium and maximize the impact of the informa-

tion. QuarkXPress layout spaces let you perfect both designs within one project. 

UNDERSTANDING PROJECT AND LAYOUT SPACE CONCEPTS

When you create a new QuarkXPress file, you create a “project.” The project con-
sists of individual layout spaces that you can use to define independent content. You
can create text that is shared between layout spaces, while specifying other text that
is restricted to one particular layout. 

WHAT IS A PROJECT?

A project is the actual QuarkXPress file and is a container for all of the docu-
ment layouts and elements. Every project contains at least one layout space,
and you can add more layout spaces to a project as your needs require. 

Since every project must contain a layout space, this guide does not refer to
files as “documents.” Instead, it refers to a “project” when discussing func-
tions that affect the entire file, and a “layout space” or “layout” when dis-
cussing functions that affect individual layouts. 

Specifications that you can append from another file are defined at the proj-
ect level. This means that they apply uniformly to every layout in the project.
Specifications that you define across an entire project are:

• Application preferences 

• Style sheets

• Colors

• H&Js

• Lists

• Dashes and stripes

• Cascading menus (Web layouts only)

• Meta tags (Web layouts only)

• Menus (Web layouts only)
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å Although every list definition you create can be used in any layout in the
project, a list only draws from the active layout when you build it.

For detailed information about creating and saving projects, see “Working
with Projects” in this chapter.

WHAT IS A LAYOUT SPACE?

A layout space or layout is the design space that you use to create content for a
specific type of job. The layout space contains your design elements, such as
pages, text, and pictures. 

QuarkXPress offers two media targets for layout spaces: print and Web. These
media targets are called medium types. When you create a layout space, you
choose the medium type that specifies how you intend to distribute your
content. Using this approach you can use one project to create content that
you will publish in different media, including print, Portable Document For-
mat (PDF), and Web pages.

When you choose the layout medium type, QuarkXPress imposes the restric-
tions and liberties that are defined for that form of distribution: print layouts
follow the parameters that applied to print documents in QuarkXPress 5.0,
and Web layouts follow the parameters that applied to Web documents in
QuarkXPress 5.0.

Each layout space uses a set of rules imposed by the medium type, but you
can take it a step further by applying different restrictions to individual lay-
out spaces that are of the same medium type. For example, you can create an
advertisement and a brochure that contain much of the same content. If they
are in different print-optimized layout spaces, you can specify different page
sizes for each, while sharing the content that the two jobs have in common.
This allows you to present and distribute your content in the fashion that
you want. 

Many specifications are defined at the layout space level rather than the proj-
ect level. This means that you can specify them differently for every layout in
the project. Following are important details about specifications that you
define for individual layouts:

• You define page settings at the layout level in QuarkXPress 6.0, so you will no
longer find the Document Setup command in the File menu for print lay-
outs. To specify the page settings, choose Layout & Layout Properties.

• Each layout space can contain as many as 2,000 pages.

• Each print layout space can be as large as 48" x 48" in size (or 24" x 48" for a
two-page spread).

• A project can contain as many 25 layout spaces.
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You can change the following specifications for an individual layout space by
changing settings when the layout space is active:

• Layout preferences (QuarkXPress & Preferences & Layout or Web
Layout on Mac OS or Edit & Preferences & Layout or Web Layout on
Windows)

• Kerning (Style & Kern) (Print layouts only)

• Tracking (Style & Track) (Print layouts only)

• Hyphenation Exceptions (Utilities & Hyphenation Exceptions)

• Trapping (Window & Show Trap Information) (Print layouts only)

• Zoom values

∫ If the Nonmatching Preferences alert displays when you open a project, you
are prompted to choose Keep Document Settings or Use XPress Preferences.
If you click Use XPress Preferences, all layouts revert to the preference set-
tings in your “XPress Preferences” file. If you click Keep Document Settings,
the project will retain the preferences that you previously specified for each
layout. For more information about the Nonmatching Preferences alert, see
A Guide to QuarkXPress: Using QuarkXPress.

When you cut and paste or copy and paste items to a different medium type
than the original layout, media-dependent items (for example, form controls)
will be altered. For information about how QuarkXPress treats media-depend-
ent items during this conversion, see “Print/Web Conversion Issues” in the
Appendices in A Guide to QuarkXPress: Using QuarkXPress.

For detailed information about creating and editing layout spaces, see “Creat-
ing, Editing, and Deleting Layout Spaces” in this chapter.

SYNCHRONIZING TEXT

The concept of sharing text content among different layout spaces is called
synchronizing text. Synchronizing allows you to create text content that is
either independent of or dependent on another layout space. 

For example, say your project contains a print layout and a Web layout. You
want the layouts to share some of the same text, but they will also contain
some different text. Enter the shared text into the layout independent space,
called the Synchronized Text palette, which allows you to edit the text char-
acters simultaneously in both layouts. Text that you don’t want to synchro-
nize is independent of the other layout spaces, and you enter it directly in
the appropriate layout.

Chapter #: Chapter Title

9

Name of Section



∫ You can copy or cut and paste synchronized text to or from any layout space,
but the new text will not be synchronized.

For more information about synchronizing text, see “Synchronizing Text
Among Layouts” in this chapter.

WORKING WITH PROJECTS

A “project” encompasses a QuarkXPress file and all the layout spaces and page
items that the file contains. Once you have created a project and its default layout
space, you can add as many as 25 layouts to create a project you can output to
print, PDF, or the Web. 

CREATING A NEW PROJECT

Every QuarkXPress project contains at least one layout space. Therefore,
when you create a project, you must specify a default layout space for the file.
You can specify a print-optimized or Web-optimized default layout. 

To create a new project:

1 Choose File & New & Project (C+N on Mac OS, Ctrl+N on Windows). The
New Project dialog box displays.

2 Use the default layout name or enter a new name for the layout in the Lay-
out Name field.

3 Choose the default layout medium type from the Default Layout pop-up menu:

• Choose Print to create a layout that is optimized for printed output.

• Choose Web to create a layout that is optimized for a Web page.

When you choose the layout medium type, QuarkXPress imposes the restric-
tions and liberties that are defined for that form of distribution. Print layouts
follow the parameters applied to print documents in QuarkXPress 5.0, and
Web layouts follow the parameters applied to Web documents in
QuarkXPress 5.0.

4 After you choose a layout type, the New Project dialog box displays parame-
ters appropriate to the layout type. Specify the remaining layout parameters
and then click OK.

5 The “A-Master A” master page is defined by the parameters you specified for
the default layout space.

å To open the New Project dialog box with Web as the default medium type,
press C+Option+Shift+N (Mac OS) or Ctrl+Alt+Shift+N (Windows).
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When you specify a print-optimized layout (top), the New Project dialog box displays
parameters for print layouts. When you specify a Web-optimized layout (bottom), the New
Project dialog box displays parameters for Web layouts.
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SAVING AND NAMING A QUARKXPRESS PROJECT

When you save a QuarkXPress project for the first time the Save As dialog box
displays. Use this dialog box to specify where and how the project will be saved.

Use the Save As dialog box to save and name a new project. 

To use the Save As feature:

1 Choose File & Save As (C+Option+S on Mac OS, Ctrl+Alt+S on Windows). 

2 On Mac OS, enter a name for the project in the Save As field. On Windows,
enter a name for the project in the File Name field.

3 In the Where area (Mac OS) or Save In area (Windows), use the dialog box
controls to specify a location for the new project file.

4 Choose 6.0 or 5.0 from the Version pop-up menu: 

• If you chose 6.0, choose Project or Project Template from the Type 
pop-up menu.

• If you chose 5.0, choose Document or Template from the Type pop-up menu.

5 Mac OS only: Check Include Preview to create a thumbnail preview of the
project in the Open dialog box. The preview is the first page of the layout
space that is active when you save the project.

6 Click Save.
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∫ For information about how QuarkXPress handles projects when you save
as a 5.0 document, see “Saving Projects as QuarkXPress 5.0 Documents” in
this chapter.

Earlier versions of QuarkXPress are unable to open projects saved in the cur-
rent version of QuarkXPress.

å Windows only: The file extension for a QuarkXPress project is “.qxp.” The file
extension for a project template is “.qpt.”

SAVING PROJECTS AS QUARKXPRESS 5.0 DOCUMENTS

When you save a project as a 5.0 document and the project contains multiple
layouts, an alert displays to notify you that you are downsaving multiple lay-
outs. If you elect to continue, QuarkXPress creates a folder that is named the
same as the project and places each layout space in that folder as a separate
document or template file, appropriate to the layout’s medium type. For
example, QuarkXPress saves each Web-optimized layout as a QuarkXPress 5.0
Web document or template, and it saves each print-optimized layout as a
QuarkXPress 5.0 print document or template.

When you open a QuarkXPress 5.0 document in QuarkXPress 6.0, all 5.0
information is retained. However, when you save a 6.0 project as a 5.0 docu-
ment, many 6.0-specific attributes are lost or altered:

• If the project specifies As Is composite color output, settings default to com-
posite RGB color space in the Print dialog box, the Save Page as EPS dialog
box, and the PDF Options dialog box.

• When you downsave a project that specifies DeviceN output, the composite
color space is changed to Composite CMYK.

• Layer locking behavior reverts to 5.0 functionality. 

OPENING OLDER QUARKXPRESS FILES

You can use QuarkXPress 6.0 to open any QuarkXPress document or template that
has been saved as QuarkXPress 3.3x, 4.0, or 5.0.

A print document saved in QuarkXPress 5.0 or earlier opens as a project with
a single, print-optimized layout. A Web document opens as a project with a
single, Web-optimized layout. QuarkXPress assigns the legacy document’s
name as the project name and the default layout space name. 

Windows only: QuarkXPress retains the file extension (“.qxd” or “.qwd”) for
the legacy file until you save the file as a QuarkXPress 6.0 project (File &
Save As). 
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å To update an older document’s version to QuarkXPress 6.0, press Option
(Mac OS) or Alt (Windows) as you click Open in the Open dialog box
(File & Open).

CREATING,  EDITING,  AND DELETING LAYOUT SPACES

Each project contains a default layout space, and you can create additional layout
spaces as needed. You can edit, duplicate, or delete a layout space. 

NAVIGATING AMONG LAYOUTS 

The project window replaces the document window of previous QuarkXPress
versions. When you create a new project, a tab for the default layout displays
at the bottom of the project window. As you create additional layouts,
QuarkXPress adds a tab for each layout at the bottom of the project window.
The tab displays the name of the layout along with a printer icon for print
layouts, and a Web icon for Web layouts.

At the bottom of the project window, QuarkXPress displays a tab for each layout in the
project.

To display a different layout, click the tab for the layout that you want to
view. Alternatively, you can use commands in the Layout menu to specify
which layout becomes active:

• Choose Previous to activate the layout tab that is positioned to the immedi-
ate left of the active layout.

• Choose Next to activate the layout tab that is positioned to the immediate
right of the active layout.

• Choose First to activate the far left layout tab.

• Choose Last to activate the far right layout tab.

• To activate a specific layout, choose Go To, and then choose the layout you
want from the submenu. 

CREATING ADDITIONAL LAYOUTS

When you create a new project, one layout space is created by default. You
can later add additional layouts to the project as needed for your particular
job. To create a layout:
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1 In an open QuarkXPress project, choose Layout & New (XXXXXX on
Mac OS, XXXXXX on Windows). Alternatively, you can click a layout tab
and choose New from its context menu. The New Layout dialog box dis-
plays.

2 Use the default layout name or enter a new name for the layout in the Lay-
out Name field.

3 Choose the default layout medium type from the Layout Type pop-up menu:

• Choose Print to create a layout that is optimized for printed output.

• Choose Web to create a layout that is optimized for a Web page.

When you choose the layout medium type, QuarkXPress imposes the restric-
tions and liberties that are defined for that form of distribution. Print layouts
follow the parameters applied to print documents in QuarkXPress 5.0, and
Web layouts follow the parameters applied to Web documents in
QuarkXPress 5.0.

4 After you choose a layout type, the New Layout dialog box displays parame-
ters appropriate to the layout type. Specify the remaining layout parameters
and then click OK.

5 QuarkXPress adds a new Layout tab to the bottom of the project window.

Use the New Layout dialog box to specify parameters for a layer as you create it.
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DUPLICATING A LAYOUT

When you want to create two similar layouts, you can duplicate one layout to
copy its items and content to another. You can adjust the new layout’s
parameters as you create the copy. To duplicate a layout:

1 Display the layout you want to duplicate.

2 Choose Layout & Duplicate, or choose Duplicate from the layout tab con-
text menu.

3 Specify the layout parameters for the new layout and then click OK.

Here are a few things to consider when you duplicate a layout:

• Text that is synchronized in the source layout is synchronized in the dupli-
cate layout. 

• Pasteboard items that are not within the source layout’s page boundaries are
not included in the duplicate layout.

• When you choose a different medium type than the original layout, media-
dependent items (for example, form controls) will be altered. For information
about how QuarkXPress treats media-dependent items during this conver-
sion, see “Print/Web Conversion Issues” in the Appendices of A Guide to
QuarkXPress: Using QuarkXPress.

∫ If the duplicated layout is smaller than the original, the top leftmost item is
positioned at the 0,0 coordinates, so items positioned in the lower right of
the layout space may not display. To move undisplayed items to the visible
window, resize the duplicated layout space to the source layout’s size
(Layout & Layout Properties) so you can see the items, then move the items
to position them within the new parameters. After you have moved the
items, you can resize the layout space back to its correct size.

EDITING LAYOUT PROPERTIES

At any given time, you can rename a layout or change its medium type. To
change properties for a layout:

1 Display the layout you want to edit.

2 Choose Layout & Layout Properties or choose Layout Properties from the
Layout tab context menu. The Layout Properties dialog box displays.
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Context menu for a Layout tab

3 Specify the layout parameters that you want to change.

4 Click OK to apply the changes.

The Layout Properties dialog box lets you change the name or medium type of a layout.

CHANGING THE LAYOUT MEDIUM TYPE

To change the layout medium type:

1 Display the layout you want to edit.

2 Choose Layout & Layout Properties or choose Layout Properties from the
layout tab context menu. The Layout Properties dialog box displays.
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3 Choose the new medium type from the Layout Type pop-up menu.

4 Click OK. 

5 A confirmation dialog box displays to inform you that content or settings
may be affected if you change the layout medium type. 

When you change medium types, this alert notifies you that the content of the layout may
not be appropriate for the new medium.

6 If you click OK to continue, the Layout Properties dialog box displays again,
this time with parameters appropriate to the new medium type. 

7 Specify the layout parameters for the new medium type and then click OK.

∫ When you apply a different medium type to a layout, content may be
changed to accommodate the new layout medium type. For example, if you
change a print-optimized to a Web-optimized layout, TIFF files will be
changed to JPEG format.

Some items, for example form controls, are dependent on a particular
medium type. When you change the medium type of a layout, items that are
restricted by medium type will be altered. For information about how
QuarkXPress treats media-dependent items during this conversion, see
“Print/Web Conversion Issues” in the Appendices in A Guide to QuarkXPress:
Using QuarkXPress.

DELETING A LAYOUT

QuarkXPress makes it easy to remove a layout from your QuarkXPress proj-
ect. To delete a layout:

1 Display the layout you want to edit.

2 Choose Layout & Delete (XXXXXX on Mac OS, XXXXXX on Windows) or
choose Delete from the Layout tab context menu. 

3 Confirm the deletion by clicking OK.

∫ If a project contains a single layout space, you cannot delete that layout.
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WORKING WITH MULTIPLE LAYOUT SPACES

While most QuarkXPress features work the same within layout spaces as they did in
QuarkXPress 5.0, you must consider the following when you design projects that
contain multiple layout spaces:

• Layers apply to the layout space that is active when you create and edit them.

• When you perform a project-level action (Edit & Undo), the action is
added to the Undo History in all layout spaces. For example, if you create a
color then create a box and apply the color to it in “Layout 1,” you can
then display “Layout 2” and undo the color creation. If you do this, the
color is removed from both layouts, and the box creation performed in
“Layout 1” is also undone because it was performed after the color was
created and actions cannot be undone out of sequence.

• When you check spelling (Utilities menu), QuarkXPress checks only the
active layout space.

• The Find/Change feature (Edit menu) only searches the active layout space.

• Although a list definition can be used in any layout in the project, a list only
draws from the active layout when you build it. This lets you define your list
once in the project, and then build a different list for each layout space.

• You can add a project to a book when the project contains a single, print-
optimized layout space. If your project contains multiple layout spaces, you
must move the relevant layout space to a new project by itself so that you
can synchronize it with other book chapters.

You cannot change the medium type of a layout space from print to Web
while it is included in a book.

• Indexes apply on a layout-by-layout basis so that you can build a different
index for each individual layout in your project.

PRINTING AND EXPORTING LAYOUTS

Output from QuarkXPress occurs on a layout-by-layout basis. The layout
space that is active at the time you choose an output command is the layout
that prints or exports.

PRINTING AND EXPORTING FROM A PRINT-OPTIMIZED LAYOUT

When you output from a print layout, the following rules apply:

• When you choose File & Export & PDF, QuarkXPress exports the active layout.

• When you choose File & Save Page as EPS, QuarkXPress saves the active
layout page.

• When you choose File & Collect for Output, QuarkXPress gathers files for
the active layout.

• When you choose File & Print, the active layout prints.
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PRINTING AND EXPORTING FROM A WEB-OPTIMIZED LAYOUT

When you output from a Web layout, the following rules apply:

• When you choose File & Export & HTML, QuarkXPress exports the active
layout.

• When you choose File & Print, the active layout previews and prints from
your Web browser.

SYNCHRONIZING TEXT AMONG LAYOUTS

Synchronizing allows you to create text content that you can update simultaneously
in multiple layouts — when you update synchronized text in one layout, the edits
apply to the same text in every layout that contains it. This allows you to target
your synchronized text to a specific medium type or layout space, or you can share it
among different medium types and layout spaces.

You synchronize text entries by adding text to the layout independent space (the
Synchronized Text palette) and then inserting the text from the layout independ-
ent space into other layout spaces.

UNDERSTANDING THE SYNCHRONIZED TEXT PALETTE

Synchronized text resides in the layout independent space that is called the
Synchronized Text palette. You can use this palette to store text that is
already synchronized to one or more layout spaces, but you can also use it to
store text that is not synchronized to any layouts. This provides you with a
container to store text that you may want to synchronize in the future. To
display the Synchronized Text palette, choose Window & Show Synchro-
nized Text. 

å This section contains a brief overview of the Synchronized Text palette. For
specific details about synchronizing text, see the following sections in this
chapter.
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The Synchronized Text palette is the storage container for layout-independent text.

Across the top of the Synchronized Text palette are five buttons:

• To add a text entry to the layout independent space, select text in a layout
space and then click the Synchronized Text button . Once you have
added it, you can share that text with multiple layouts.

• To insert synchronized text into a text box or path, select a text entry in the
palette and click the Insert Text button . Alternatively, you can drag the
text entry and drop it on a text box or path to insert it into a layout.

• To change the name of a text entry, select the entry in the palette and click
the Edit Name button .

• To unsynchronize all instances of synchronized text, select the entry in the
palette and click the Unsynchronize All button .

• To unsynchronize all instances of synchronized text and remove the text
entry from the Synchronized Text palette, select a text entry in the palette
and click the Remove Entry button .

THE TEXT ENTRY L IST

The Text Entry list displays in the top section of the Synchronized Text
palette. This area lists all text entries that you have added to the layout inde-
pendent space. Text entries display in this area regardless of whether it is syn-
chronized to any layout spaces.
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The top section of the Synchronized Text palette lists all text entries that have been syn-
chronized in the project.

THE TEXT USAGE AREA

The Text Usage area is the lower section of the Synchronized Text palette.
This area displays a list of layouts that are synchronized with the selected
text entry.

If no information displays in the Text Usage area, then the selected text
entry is not synchronized to any layout spaces.

The lower section of the Synchronized Text palette lists all layouts that have been syn-
chronized with the selected text entry.

CREATING A SYNCHRONIZED TEXT ENTRY

Before you can share text from one layout space to another, you must add it
to the Synchronized Text palette. To add a text entry to the Synchronized
Text palette:

1 In a layout where you want the shared text, create a text box or text path and
enter the text that you want to synchronize with other layouts.
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2 Select the text to synchronize by selecting the text box or text path with the
Content tool E or placing the Text Insertion bar I in the text using the
Content tool E.

3 In the Synchronized Text palette (Window & Show Synchronized Text,
click the Synchronize Text button . Alternatively, you can choose
Style & Synchronize Text or display the text box or text path context menu
and choose Synchronize Text.

4 The Synchronize Text dialog box displays. Enter a name for the text entry in
the Entry Name field and then click OK. 

5 QuarkXPress lists the new entry in the Text Entry list in the Synchronized
Text palette. 

∫ Attributes that you apply to the text before adding it to the Synchronized
Text palette apply to the text in all layouts that you synchronize with it,
unless you change the attributes in the layout.

You cannot synchronize text to or from a text box or path residing on a
master page.

If you change the content type of a box containing synchronized text
(Item & Content & Picture or None), the content of that box is no longer
synchronized.

INSERTING SYNCHRONIZED TEXT INTO A LAYOUT

After you have added an entry to the Synchronized Text palette, you can
then insert it into other layout spaces that will share the text:

1 In the layout where you want to insert synchronized text, create a text box or
text path and select it with the Content tool E.

2 Select the appropriate synchronized text entry in the Synchronized Text
palette Text Entry list.

3 Click the Insert Text button , or display the Synchronized Text palette
context menu and choose Insert Text into Text Box. Alternatively, you can
drag the text entry from the Synchronized Text palette Text Entry list and
drop it into the selected text box or path. 

After you have synchronized text with a text box or text path, a visual indica-
tor displays on each of the box or path resizing handles.
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Visual indicators display on the box resizing handles so you can readily see that the box
contents are synchronized.

∫ If you insert synchronized text into a text box or path that already contains
text, the previous contents are replaced by the shared text.

Although the text can be synchronized, the text attributes are not synchro-
nized; after you have synchronized the text, you can then apply different text
styles or attributes in each layout. Remember, however, that style sheets are
defined at the project level. If you modify the attributes in a style sheet that
was applied to any portion of text before it was added to the Synchronized
Text palette, QuarkXPress updates all synchronized instances that you have
not modified with local formatting.

You cannot synchronize text to or from a text box or path residing on a
master page.

EDITING THE NAME OF A SYNCHRONIZED TEXT ENTRY

At any time, you can rename a text entry that you have listed in the Syn-
chronized Text palette:

1 Select the text entry in the Text Entry list in the Synchronized Text palette.

2 Click the Edit Name button or display the palette context menu and
choose Edit Name. The Edit Name dialog box displays.

3 Enter the new name in the Entry Name field.

4 Click OK.

UNSYNCHRONIZING TEXT

After you have synchronized text among various layouts, you can unsynchro-
nize a single instance of a text entry without affecting other layouts that use
the shared text. You can also unsynchronize all instances of a text entry so
that it is no longer shared by any layout spaces. 
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UNSYNCHRONIZ ING ONE INSTANCE OF A TEXT ENTRY

To unsynchronize a single instance of a text entry:

1 In the layout space, select the text box containing the synchronized text
using the Content tool E.

2 Choose Style & Unsynchronize Text. Alternatively, you can display the
context menu and choose Unsynchronize Text.

3 An alert displays to let you confirm that you want to unsynchronize the
selected box content. Click Yes.

4 When you unsynchronize a text instance the text remains in the text box,
but it is no longer linked to the Synchronized Text palette or any other lay-
out spaces. You can then edit that text independently of text in any other
layout space.

UNSYNCHRONIZ ING ALL INSTANCES OF A TEXT ENTRY

To unsynchronize all instances of a text entry:

1 Select the text entry in the Text Entry list in the Synchronized Text palette.

2 Click the Unsynchronize All button or display the palette context menu
and choose Unsynchronize All.

3 An alert displays to let you confirm that you want to unsynchronize all
instances of the selected text. Click Yes.

4 When you unsynchronize a text entry the text remains in each of the text
boxes that were synchronized with that text entry, although their text is no
longer synchronized. You can then edit that text independently of text boxes
in any other layout space.

When you unsynchronize all instances, the text entry remains in the Syn-
chronized Text palette so that you can later re-synchronize the text. For
information about resynchronizing text, see “Resynchronizing Text” in this
section.

RESYNCHRONIZING TEXT

To resynchronize text after you have unsynchronized it, treat it as a new syn-
chronization:

1 In the layout space where you want to resynchronize text, select the text box
with the Content tool E.

2 Select the text entry in the Text Entry list in the Synchronized Text palette.

3 Click the Insert Text button , or display the Synchronized Text palette
context menu and choose Insert Text into Text Box. Alternatively, you can
drag the text entry from the Synchronized Text palette Text Entry list and
drop it in the selected text box.
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4 The text box content is replaced with the text contained in the text entry
from the Synchronized Text palette. 

∫ When you insert synchronized text, QuarkXPress replaces all text box con-
tents with the synchronized text regardless of the range of text that you select
before you initiate the insertion action.

REMOVING SYNCHRONIZED TEXT FROM THE SYNCHRONIZED TEXT

PALETTE

When the Synchronized Text palette contains a text entry that you no
longer want, you can remove it from the palette:

1 Select the text entry in the Synchronized Text palette Text Entry list.

2 Click the Remove Entry button or display the palette context menu and
choose Remove Entry.

3 An alert displays to let you confirm that you want to unsynchronize all
instances of the selected entry when you remove the entry from the palette.
Click Yes.

After you remove a text entry from the Synchronized Text palette, the text
remains in each of the text boxes that were synchronized with that text
entry, although the text is no longer synchronized. You can then edit that
text independently of text boxes in any other layout space.
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Chapter 2: Mac OS X Support — Mac OS

Only

This version of QuarkXPress is designed specifically to run in a native Mac OS X

environment, and supports XTensions™ software that are developed to run in native

Mac OS X. When you run QuarkXPress on Mac OS X, you will notice visible

changes in QuarkXPress, including the introduction of the Aqua appearance, a cou-

ple of new menus, and font family grouping.

FAMILIARIZING YOURSELF WITH THE AQUA APPEARANCE

The immediately noticeable change in QuarkXPress for Mac OS is the intro-
duction of the OS X Aqua appearance. The QuarkXPress interface has been
updated to run in Mac OS X native mode with the same appearance as other
OS X applications. 

Some dialog boxes and palettes, and the fields and options within them, were
resized or moved slightly when QuarkXPress was updated to be compatible
with OS X standards. Although the dialog boxes, palettes, and project
windows display differently than in previous versions of QuarkXPress, you’ll
find that the feature options themselves remain the same — you can con-
tinue to use the pictures in A Guide to QuarkXPress: Using QuarkXPress as your
reference to features and their options. In situations where the QuarkXPress
interface has changed significantly as a result of OS X compatibility or
QuarkXPress 6.0 feature enhancements, the change is explained in this
addendum.

The Aqua appearance has no effect on output of QuarkXPress projects.

USING THE QUARKXPRESS AND WINDOW MENUS

Two additions to the QuarkXPress menu bar on Mac OS are a direct result of
Mac OS X compatibility: the QuarkXPress menu and the Window menu.

QUARKXPRESS MENU

The QuarkXPress menu is a standard Mac OS application menu that contains
commands for QuarkXPress, including About QuarkXPress, Show and Hide
commands for the Finder, preference commands, and the Quit command.
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For details about this menu, see the “Other Changes in QuarkXPress 6.0”
chapter in this document.

WINDOW MENU

The Window menu is new to QuarkXPress for Mac OS. The addition of this
menu makes QuarkXPress for Mac OS more consistent with QuarkXPress for
Windows. For details about this menu, see the “Other Changes in
QuarkXPress 6.0” chapter in this document.

GROUPING FONTS BY FAMILY

QuarkXPress now groups fonts within their font families. When you choose a
font from any Font pop-up menu, a submenu displays, showing you all the
typefaces available for the chosen font. Font menus are located in the Style
menu, the Measurements palette (View & Show Measurements), the
Find/Change palette (Edit & Find/Change), the Replace Font dialog box
(Utilities & Usage & Fonts tab & Replace), the Edit Character Style Sheet
dialog box (Edit & Style Sheets), and the Character Attributes dialog box
(Style & Character).

Use the Font submenu to choose a typeface within its font family.
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Chapter 3: Windows XP Support —

Windows Only

QuarkXPress 6.0 will run on Windows XP. Although there are some changes to the

appearance of QuarkXPress, the functionality remains largely the same.

FAMILIARIZING YOURSELF WITH THE WINDOWS XP

APPEARANCE

The most noticeable change in QuarkXPress for Windows XP is the introduc-
tion of the Windows XP appearance. The QuarkXPress interface has been
updated to run in Windows XP with the same appearance as other
Windows XP applications.

Some dialog boxes and palettes, and the fields and options within them, were
resized and moved slightly when QuarkXPress was updated to reflect the
Windows XP appearance. However, the controls within dialog boxes remain
the same — you can continue to use the screen shots in A Guide to
QuarkXPress as a reference to features.

The Windows XP appearance has no effect on the output of QuarkXPress
projects.

The Windows XP appearance in the New Project dialog box
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UNDERSTANDING WINDOWS XP SUPPORT

• You cannot run two instances of QuarkXPress on the same machine; if you
try to launch a second instance of QuarkXPress from a different user account
(using the Fast User Switching feature of Windows XP) while the first
instance is running, you will receive an alert.

• QuarkXPress cannot run simultaneously from multiple terminal server
clients.

• QuarkXPress will work with Remote Desktop if no other instance of
QuarkXPress is running on the machine.

• QuarkXPress will work with the onNow power management system of
Windows XP. When the computer enters Sleep mode, QuarkXPress also pow-
ers down. While the computer remains in Sleep mode, QuarkXPress does not
perform auto backups or check for a Quark License Administrator (QLA)
license server. When you wake up the system, QuarkXPress resumes normal
functioning.
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Chapter 4: Multiple Undo

How many times have you taken several steps to edit an item, only to decide that

you preferred the way it looked before you changed it? The Multiple Undo feature

extends the Undo and Redo capabilities that you’ve always used with

QuarkXPress. Now you can undo several consecutive edits, returning an item to its

previous state. Use Multiple Undo to reverse one action, a series of actions, or to

reimplement a series of actions that you have “undone.” 

SETTING PREFERENCES FOR MULTIPLE UNDO

QuarkXPress lets you set preferences for Multiple Undo options. Use the Prefer-
ences dialog box Undo pane to specify which keyboard command will invoke the
Redo command, and to define the size of your Undo History.

To display the Preferences dialog box Undo pane, choose QuarkXPress & Pref-
erences on Mac OS or Edit & Preferences on Windows, and then click Undo in
the pane on the left.

Specify Multiple Undo settings in the Preferences dialog box Undo pane.

SPECIFYING THE KEYBOARD COMMAND FOR REDO

You can specify which keyboard command to use for the Redo function. 

On Mac OS, C+Shift+Z is the default keyboard command for the Redo func-
tion. To specify a different keyboard command, choose C+Z or C+Y from
the Redo Key pop-up menu. 
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∫ If you designate C+Z for Redo, then press C+Option+Z to step back through
the Undo History. 

The Undo keyboard command remains C+Z, regardless of your preference
setting for Redo. This lets you toggle back and forth between Undo and
Redo, as in previous versions of QuarkXPress.

On Windows, Ctrl+Y is the default keyboard command for the Redo func-
tion. To specify a different keyboard command, choose Ctrl+Shift+Z or
Ctrl+Z from the Redo Key pop-up menu. 

Use the Redo pop-up menu to choose the keyboard command for the Redo function.

∫ If you designate Ctrl+Z for Redo, then press Ctrl+Alt+Z to step back through
the Undo History.

The Undo keyboard command remains Ctrl+Z, regardless of your preference
setting for Redo. This lets you toggle back and forth between Undo and
Redo, as in previous versions of QuarkXPress.

SPECIFYING THE SIZE OF THE UNDO HISTORY

QuarkXPress lets you specify the number of actions that can be stored in your
Undo History. To do this, enter the maximum number of actions that you
want to keep in your Undo History in the Maximum History Actions field.
The Undo History can hold as many as 30 actions; the default setting is 20.

When the number of actions exceeds the maximum that you specify, the old-
est action is removed from the list. 

UNDERSTANDING NEW UNDO CAPABILITIES

You can use Multiple Undo to reverse or reimplement almost any action that
modifies the project or its items. You can use it to undo many actions that
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you couldn’t reverse in previous versions of QuarkXPress. Following is a list
of operations that are new to the Undo feature in QuarkXPress 6.0:

• Linking and unlinking text boxes

• Get Text

• Get Picture

• Crop to Box for runaround and clipping paths

• Convert Text to Table, Convert Table to Text, and Convert Table to
Group

• Edits that you enter during a session in the Style Sheets dialog box (Edit &
Style Sheets)

• Several functions in the Layers palette, including New Layer, Delete Layer,
Duplicate Layer, Move Item to Layer, Merge Layers, Edit Layer Attributes,
Move Layer, and Delete Unused Layers

• Page operations such as Insert Pages, Delete Pages, Move Pages, and Delete
Master

å Although you cannot undo or redo actions that you perform in the Edit Col-
ors dialog box, you can use Multiple Undo to reverse several color edits
when you perform them from the Colors palette context menu. These
actions include New Color, Edit Color, Duplicate Color, Delete Color,
Make Spot, and Make Process.

∫ For information about how Multiple Undo works with regard to layout
spaces, see the “Layout Spaces” section of this document.

UNDOING MULTIPLE ACTIONS

In previous versions of QuarkXPress, the Undo command (Edit menu) reversed only
one action. Depending on the situation, either Undo or Redo displayed in the menu,
but not both. With the Multiple Undo feature, the Redo command now occupies
its own position in the Edit menu so that you have the option to reimplement multi-
ple actions, as well as having the option to reverse your most recent action. 

To reverse the last action that you implemented, choose Edit & Undo (C+Z
on Mac OS, Ctrl+Z on Windows). You may then choose Edit & Undo again
to reverse the next most recent action, and so on until no actions remain in
the Undo History.

REVERSING ACTIONS USING THE UNDO BUTTON

The Undo button ( on Mac OS, on Windows) functions like the
Undo command in the Edit menu. This button is available at the bottom of
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the project window whenever the last action you performed is reversible.
When you click it, QuarkXPress reverses the last action that you initiated.
Continue clicking the button to reverse each subsequent action in reverse
order of how you implemented them. For information about reversing multi-
ple actions in one operation, see the section “Using the Undo History.”

å When the Undo History is empty, the Undo command and the Undo button
are unavailable.

USING THE UNDO HISTORY

Each time you perform an action, QuarkXPress adds it to the Undo History
pop-up menu. To display this menu, click and hold the Undo button 
(Mac OS) or click and hold the disclosure triangle next to the
Undo button (Windows).

Actions are listed sequentially in the Undo History pop-up menu, with your
most recent actions at the top. Actions are selected as you drag the mouse
down the menu. When you release the mouse, all the actions that you
selected are reversed. 

You cannot select non-consecutive actions to undo; when you click an item
in the list, that action and all subsequent actions are selected and reversed.

Use the Undo History pop-up menu to choose a series of consecutive actions to undo.

CLEARING THE UNDO HISTORY

When you initiate an action that cannot be reversed, QuarkXPress automati-
cally clears the Undo History. 
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∫ There are a few exceptions to this rule; the following actions do not clear the
Undo History:

• Creating a new master page

• Duplicating a master page

• Applying a master page to a project page

• Creating a ruler guide on a project page

• Moving a ruler guide on a project page

• Deleting a ruler guide on a project page

• Checking Use OPI for a picture (Item & Modify & OPI tab).

QuarkXPress also empties the Undo History when you close a project or
when you choose File & Revert to Saved. However, merely saving a project
(File & Save) does not cause QuarkXPress to empty the Undo History.

When the Undo History is empty, the button is unavailable.

REDOING MULTIPLE ACTIONS

Previously, the Redo command was positioned in the same place as the Undo com-
mand in the Edit menu. Depending on the situation, either Undo or Redo dis-
played in the menu, but not both. With Multiple Undo, the Redo command now
has its own position in the menu and its own keyboard shortcuts. Choose Edit &
Redo to reimplement actions that you previously reversed. When you choose
Edit & Redo, QuarkXPress reimplements your last reversed action. Then you may
choose Edit & Redo again to reimplement the next most recent action reversal, and
so on until no actions remain in the Redo History.

REIMPLEMENTING ACTIONS USING THE REDO BUTTON

The Redo button ( on Mac OS, on Windows) functions like the
Redo command in the Edit menu. When you click it, QuarkXPress reimple-
ments the last action that you reversed. Continue clicking the button to
reimplement each successive action reversal. For information about reimple-
menting multiple actions in one operation, see the section “Using the Redo
History.”

å When the Redo History is empty, the Redo command and the button
are unavailable.
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USING THE REDO HISTORY

Each time you undo an action, QuarkXPress adds it to the Redo History pop-
up menu. To display this menu, click and hold the Redo button 
(Mac OS) or click and hold the disclosure triangle next to the Redo but-
ton (Windows).

Reversed actions are listed sequentially in the Redo History pop-up menu,
with the most recent reversals at the top. Actions are selected as you drag the
mouse down the menu. When you release the mouse, all the actions that you
selected are reimplemented. 

You cannot select non-consecutive actions to redo; when you click an item in
the list, that action and all subsequent actions are selected and reimple-
mented.

Choose multiple options in the Redo History pop-up menu to reverse a series of consecu-
tive actions.

CLEARING THE REDO HISTORY

You will discover that the Redo History is usually empty. This is because
QuarkXPress clears the Redo History when you perform an action other than
Undo or Redo. When the Redo History is empty, the button is unavail-
able.
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Chapter 5: Tables Enhancements

The QuarkXPress tables feature is even more powerful than before. For instance,

you can link text cells to any text box in a layout and apply clipping paths to pic-

tures in picture cells. This chapter explains these and other enhancements of the

tables feature.

LINKING TEXT CELLS

You can now link text cells in a table to any text box in a QuarkXPress layout, or
link cells to one another.

APPLYING AUTOMATIC TEXT CELL LINKING

To automatically link text cells in a table:

1 Select the Table tool Ï and draw a table. When you release the mouse but-
ton, the Table Properties dialog box displays.

The Table Properties dialog box

2 Click Text Cells to create a table of text cells.

3 Click Link Cells to automatically link text cells in the table.

4 When Link Cells is checked, the Link Order pop-up menu is available.
Choose from four options:
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• Choosing Left to Right, Top Down links text cells starting with the leftmost
cell of the top row and continuing across to the rightmost cell of the top row;
that cell is then linked to the leftmost cell of the second row, and linking
continues from left to right across the row.

• Choosing Right to left, Top Down links text cells starting with the rightmost
cell of the top row and continuing across to the leftmost cell of the top row;
that cell is then linked to the rightmost cell of the second row, and linking
continues from right to left across the row.

• Choosing Top Down, Left to Right links text cells starting with the leftmost
cell of the top row and continuing down to the leftmost cell of the bottom
row; that cell is then linked to the second leftmost cell of the top row and
linking continues from top to bottom down the column.

• Choosing Top Down, Right to Left links text cells starting with the right-
most cell of the top row and continuing down to the rightmost cell of the
bottom row; that cell is then linked to the second rightmost cell of the top
row and linking continues from top to bottom down the column.

å You can also specify the linking order of text cells by selecting a table and
choosing Item & Modify. Click the Table tab and choose an option from
the Link Order pop-up menu.

Specifying the linking order does not automatically link text cells; you must
link text cells manually, by displaying the context menu for a table and
choosing Tables & Link Text Cells, or by selecting the table and choosing
Item & Tables & Link Text Cells.

To make a particular linking order a default setting for tables, choose
QuarkXPress & Preferences & Preferences (Mac OS) or Edit &
Preferences & Preferences (Windows) and select the Tools pane in the Pref-
erences dialog box. In the Tools list, select the Table tool and click the Mod-
ify button. In the Modify dialog box, choose an option from the Link Order
pop-up menu.

∫ If a table with manually linked text cells is selected, the Link Order pop-up
menu is not available in the Modify dialog box.

SPECIFYING TEXT CELL LINKING MANUALLY

To manually link text cells to one another, or to link text cells to another text
box in a QuarkXPress layout:

1 Select the Linking tool u and click the first text cell in the table.

2 Click the text cell you want to link to, or click the text box you want to link
the first text cell to.
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∫ You cannot link a text cell to form controls in a Web layout.

REMOVING TEXT CELL LINKING

To unlink text cells:

1 With the Content tool E, select the table containing the text cells you want
to unlink.

2 Select the Unlinking tool U.

3 Click the tailfeather or arrowhead between the linked text cells or boxes.

4 The text is unlinked. Unlinked text will reflow into the first text cell or box of
the chain; if the cell or box cannot contain the text, the overflow symbol t
will display.

UNDERSTANDING LINKING BEHAVIOR IN TABLES

When table cells are combined, text linking is not maintained and text flows
into the first cell of the range of combined cells. To re-establish text links, use
the Linking tool u to manually link text cells.

If a combined cell is split, text linking will be maintained; the text will flow
into the split cells based on the tab order specified in the Table Properties or
Modify dialog box. 

∫ Linked text cells behave the same as linked text boxes in QuarkXPress; refer
to Chapter 7, “Document Basics,” in A Guide to QuarkXPress for more infor-
mation.

DOWNSAVING LINKED TEXT CELLS

When a project containing a table with linked text cells is downsaved to 5.0
format, text linking is not maintained. If you downsave a QuarkXPress 6.0
project containing a table with linked text cells, an alert displays, offering
two choices:

• Choosing Remove Lining breaks the text links but saves the table in
QuarkXPress 5.0 format. QuarkXPress 5.0 will recognize the object as a table,
and the table can be manipulated using QuarkXPress 5.0 table controls. Text
will remain in the cells; it simply will not be linked.

• Choosing Keep Links saves the table as a group of QuarkXPress 5.0 objects.
The text cells remain linked; however, QuarkXPress 5.0 recognizes the cells as
a group of text boxes rather than a table. The converted text cells can be
manipulated individually using QuarkXPress 5.0 box controls (Item & Mod-
ify & Box tab).
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SPECIFYING CLIPPING PATHS FOR PICTURE CELLS

You can now apply clipping settings and other specifications to a picture imported
into a picture cell. To do so:

1 With the Content tool E, select the picture cell that you want to modify.

2 Choose Item & Modify. In the Clipping tab, modify the settings for the
selected picture cell. You can apply the same settings as any picture, except
that the Restrict to Box check box is unavailable for picture cells.

APPLYING COLOR TO CELLS AND TABLES

In QuarkXPress 6.0, you can apply color to a cell, to the table box, and to the
table’s gridlines. (The table box is the larger box containing all the table cells.)

APPLYING COLOR TO A TABLE CELL

1 With the Content tool E, select the table cell.

2 Choose Item & Modify. In the Cell tab, choose a color and a shade from the
Color and Shade pop-up menus in the Cell area. Click OK.

You can also use the Colors palette to apply color to a cell. To do so:

1 Choose Window & Show Colors Palette to display the Colors palette.

2 Select the table cell with the Content tool.

3 In the Colors palette, click a color in the colors list. Or, click a color swatch
in the Colors palette and drag it onto the table cell.

å You can also use an AppleScript script (Mac OS only) to modify the color of
table cells; for information about writing AppleScript scripts, see A Guide to
Apple Events Scripting.

CHANGING THE DEFAULT COLOR OF TABLE CELLS

By default, table cells are white. To change the default color of table cells:

1 Choose QuarkXPress & Preferences & Preferences (Mac OS) or Edit &
Preferences (Windows) and select the Tools pane in the Preferences
dialog box. 

2 In the Tools list, select the Table tool Ï and click Modify. 

3 In the Cell tab of the Modify dialog box, choose a color and a shade from
the Color and Shade pop-up menus in the Cell area. Click OK.
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CHANGING THE COLOR OF THE TABLE BOX

By default, the table box (the larger box that contains all the table cells) has a
color of None. To change the color of the table box:

1 With the Item tool e, select the table.

2 Choose Item & Modify. In the Table tab, choose a color and a shade from
the Color and Shade pop-up menus in the Box area. Click OK.

You can also use the Colors palette to apply color to the table box. To do so:

1 Choose Window & Show Colors to display the Colors palette.

2 Select the table with the Item tool.

3 In the Colors palette, click a color in the colors list. Or, click a color swatch
in the Colors palette and drag it onto the table.

å You can also apply a blend to a table box. To create a blend, see Chapter X,
“Box Basics,” in A Guide to QuarkXPress: Using QuarkXPress.

You can also use an AppleScript script (Mac OS only) to modify the color of
table boxes; for information about writing AppleScript scripts, see A Guide to
Apple Events Scripting.

CHANGING THE GRIDLINE COLOR

You can change a table’s gridlines to any color, including None. To change an
individual gridline:

1 With the Content tool E, Shift+click to select a gridline.

2 Choose Item & Modify. In the Grid tab, choose a color and a shade from
the Color and Shade pop-up menus in the Line area. Click OK.

You can also use the Style menu to apply color to an individual gridline. 
To do so:

1 Select the gridline with the Content tool E.

2 Choose Style  & Color and select a color from the list.

You can also use the Colors palette to apply color to an individual gridline.
To do so:

1 Choose Window & Show Colors to display the Colors palette.

2 Click a color swatch in the Colors palette and drag it onto the gridline.
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å You can also use an AppleScript script (Mac OS only) to modify the color of
gridlines; for information about writing AppleScript scripts, see A Guide to
Apple Events Scripting.

To change the color of all the gridlines in a table:

1 Select the table.

2 Choose Item & Modify. In the Grid tab, choose a color and a shade from
the Color and Shade pop-up menus in the Line area. Click OK.

You can also use the Style menu to apply color to an individual gridline. 
To do so:

1 Select the gridline with the Content tool E.

2 Choose Style  & Color and select a color from the list.

CHANGING THE COLOR OF THE TABLE BOX FRAME

By default, the color of the table box’s frame is black. You can change a table
box’s frame to any color except None. To do so:

1 With the Item tool e, select the table.

2 Choose Item & Modify. In the Frame tab, choose a color and a shade from
the Color and Shade pop-up menus in the Frame area. Click OK.

You can also use the Colors palette to apply color to the table box frame. To
do so:

1 Choose Window & Show Colors to display the Colors palette.

2 Select the table with the Item tool e.

3 Click the J button in the Colors palette and select a color from the colors
list. This will also change the color of all the gridlines in the table. Or, click a
color swatch in the Colors palette and drag it onto the gridline.

å When you modify a table box’s frame, you can choose any frame style from
the Modify dialog box, including dashes and stripes. You can apply color to
the frame gap just as you do the frame gap of any box; to apply frames to
boxes, see Chapter 7, “Box Basics,” in A Guide to QuarkXPress: Using
QuarkXPress.

You can also use an AppleScript script (Mac OS only) to modify the color of
frames; for information about writing AppleScript scripts, see A Guide to Apple
Events Scripting.
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WORKING WITH GRIDLINES

REMOVING GRIDLINES

You can now remove gridlines, so that table cells abut one another. To
remove gridlines for the entire cell:

1 Select the table with the Item tool e.

2 Choose Item & Modify.

3 In the Grid tab of the Modify dialog box, enter 0 in the Width field. 
Click OK.

4 A dotted line will display to indicate the cell boundaries; this line does not
print.

You can also turn individual gridlines off. To do so:

1 Shift+click to select the gridline with the Content tool E.

2 Choose Item & Modify.

3 In the Grid tab of the Modify dialog box, enter 0 in the Width field. 
Click OK.

4 A dotted line will display to indicate the cell boundaries; this line does not
print.

∫ If you are creating tables in a Web layout, and the tables are not set to be
converted to a graphic, the gridlines cannot be removed, unless the frame
width of the table is set to 0 and all the gridlines in the table are set to 0.
However, if the table is set to be converted to a graphic, the gridlines can be
removed.

When tables are saved in QuarkXPress 5.0 format, any gridlines that are set to
0 will be converted to Hairline width.

SNAPPING GRIDLINES TO GUIDES

You can now snap a gridline to guides. To do so:

1 Choose View & Snap to Guides. When Snap to Guides is on (checked), any
gridline moved within the Snap to Guides distance will automatically snap
to guides.

2 To change the Snap to Guides distance, choose QuarkXPress &
Preferences & Preferences (Mac OS) or Edit & Preferences (Windows). In
the General pane of the Preferences dialog box, enter a new value in the
Snap Distance field. 
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OTHER TABLE IMPROVEMENTS

MAINTAINING GEOMETRY

The Maintain Geometry control (Item & Modify & Table tab) prevents the
width and height of a table from changing. When Maintain Geometry is on,
rows and columns within the table are resized proportionally to accommo-
date the changes. When Maintain Geometry is off, the table becomes larger
as the sizes of rows and columns change. The Maintain Geometry control is
now available in the Tables context menu. To apply it:

1 Select the table and display the context menu.

2 Choose Tables. In the Tables submenu, choose Maintain Geometry.

å The Maintain Geometry check box is also available in the Modify dialog box
(Item & Modify).

SPECIFYING THE ORDER OF TABLE CELLS

You can use the Tab Order pop-up menu to set the order of cells. The tab
order indicates what cell the text insertion point will jump to when you press
Control+Tab (Mac OS) or Ctrl+Tab (Windows) to jump to the next cell; Con-
trol+Shift+Tab (Mac OS) or Ctrl+Shift+Tab (Windows) to jump to the previous
cell and select its text; or the arrow keys to move from cell to cell.

When you create a table, the Table Properties dialog box contains the Tab
Order pop-up menu:

• Choosing Left to Right, Top Down orders text cells starting with the left-
most cell of the top row and continuing across to the rightmost cell of the
top row; that cell is then linked to the leftmost cell of the second row, and
ordering continues from left to right across the row.

• Choosing Right to left, Top Down orders text cells starting with the right-
most cell of the top row and continuing across to the leftmost cell of the top
row; that cell is then linked to the rightmost cell of the second row, and
ordering continues from right to left across the row.

• Choosing Top Down, Left to Right orders text cells starting with the left-
most cell of the top row and continuing down to the leftmost cell of the bot-
tom row; that cell is then linked to the second leftmost cell of the top row
and ordering continues from top to bottom down the column.

• Choosing Top Down, Right to Left orders text cells starting with the right-
most cell of the top row and continuing down to the rightmost cell of the
bottom row; that cell is then linked to the second rightmost cell of the top
row and ordering continues from top to bottom down the column.
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You can change the tab order after you create a table. To do so, select the
table and choose Item & Modify. In the Table tab, choose an option from
the Tab Order pop-up menu. Click OK. Content remains in its original cell.

å Tab order and linking order can be different.

CONVERTING TABLES TO GROUPS

You can convert a table to a group of related boxes. You might want to do
this when you save a layout containing features that are not supported in
previous versions of QuarkXPress. To convert a table to a group:

1 Select the table.

2 Display the context menu and choose Table & Convert Table to Group.

3 The table cells will be converted to a group of boxes. This group will replace
the original table.

å You can also convert a table to a group by selecting the table and choosing
Item & Table & Convert Table to Group.

WORKING WITH CELL ATTRIBUTES

Cells and gridlines can now assume the attributes of adjacent cells. This is
useful when you need to insert rows or columns that have the same format-
ting as adjacent rows and columns.

To insert rows or columns that have the same attributes as adjacent rows or
columns:

1 With the Content tool E, select a row or column.

2 Choose Item & Tables & Insert Rows or Item & Tables & Insert Columns.
Or, display the context menu and choose Tables & Insert Rows or Tables &
Insert Columns.

3 In the Insert Rows or Insert Columns dialog box, check Keep Attributes.
When Keep Attributes is checked, cells and gridlines will take on the attrib-
utes of the adjacent row or column:

• If you choose Insert Above Selection, the inserted row takes on the attrib-
utes of the row below it.

• If you choose Insert Below Selection, the inserted row takes on the attributes
of the row above it.

• If you choose Insert to Left of Selection, the inserted column takes on the
attributes of the column to the right of it.
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• If you choose Insert to Right of Selection, the inserted column takes on the
attributes of the column to the left of it.

Attributes that will be copied include: any text attributes, such as style sheets
local paragraph formatting; picture attributes, such as angle, skew, and offset;
and any settings in the Cell or Text tab of the Modify dialog box.

∫ When Keep Attributes is unchecked, inserted rows and columns use the
default table settings.

OPI ENHANCEMENTS

Any OPI settings for the layout (File & Page Setup & Options) will be
applied to pictures in picture cells.

APPLESCRIPT SCRIPTING ENHANCEMENTS

You can link text cells using AppleScript scripting. To write AppleScript
scripts, see A Guide to AppleScripting Events.
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Chapter 6: Layers Enhancements

QuarkXPress 6.0 introduces several changes to the Layers feature. Among other

enhancements, the Layers feature includes a change in the behavior of items on

locked layers and a new command in the Layers palette context menu. Most

notably, you can now specify which layers will output as you define settings in the

Print dialog box. 

PRINTING LAYERS — PRINT LAYOUT SPACES ONLY

Your workflow might require that you print different layers of a layout at different
times. In previous versions of QuarkXPress, you would handle this process by open-
ing the Attributes dialog box for each individual layer, and checking (or uncheck-
ing) Suppress Output. Now QuarkXPress lets you specify at print time which
layers will print and which ones won’t, saving you the time and trouble of opening
attributes for each individual layer. 

SUPPRESSING LAYERS AT PRINT TIME

To suppress layer printout at print time, choose File & Print to display the
Print dialog box, and then click the Layers tab.

Use the Print dialog box Layers tab to specify which layers will print.

The Layers tab displays a list of all layers in the active layout. A checkmark in
the Print column next to a layer name indicates that the layer will print.
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When you click a checkmark, it no longer displays and output is suppressed
for that layer. Click to place a checkmark in the Print column for a layer that
has previously been suppressed. 

Alternatively, you can use the pop-up menu at the top of the Print column to
indicate which layers will print: 

• Choose All to print all layers.

• Choose Yes to print selected layers.

• Choose No to suppress selected layers.

• Choose None to suppress all layers.

∫ If you have suppressed printout for an individual item (Item & Modify), that
item will never print, regardless of whether or not its layer is suppressed.

If you have hidden a layer (and thus suppressed it), checking the Print col-
umn causes the layer’s items to print.

The Layers tab is unavailable when you are printing a book. 

DISPLAYING A LIST OF LAYER INKS 

The Plates Used on Selected Layer information area displays a list of the
inks that are used on the selected layer. This includes the inks used by all
printable items, such as text, box backgrounds, and paragraph rules. If print-
out is suppressed for an item, that item’s inks will not be included in the list.

∫ The Plates Used on Selected Layer list is for your information only; the
inclusion of an ink in this list does not necessarily mean the ink will print. In
other words, if the layer is suppressed its inks still display in this list. To spec-
ify which inks will print, use the Print dialog box Output tab. For informa-
tion about the Output tab, see A Guide to QuarkXPress: Using QuarkXPress.

å When you select multiple layers, the Plates Used on Selected Layer area lists
all inks used on all of the selected layers. If an ink is used on multiple layers,
it will be listed only once.

Chapter #: Chapter Title

48

Name of Section



The Plates Used on Selected Layer area indicates which inks are used on the selected
layer.

APPLYING CHANGES TO THE LAYER

If you want to apply settings in the Layers tab to the layout, check Apply to
Layout. The settings you specify in the Layers tab will be applied to the
appropriate layers when you click Capture Settings or Print. For example, if
you uncheck the Print column for the Default layer, check Apply to Layout,
and then print the layout, the Default layer will be suppressed, and Suppress
Output will be checked in the Attributes dialog box for the Default layer. 

∫ If you check the Print column for a hidden layer and check Apply to Layout,
the layer will no longer be hidden, and its output will no longer be sup-
pressed.

OTHER LAYERS ENHANCEMENTS

LOCKING LAYERS

When you lock a layer in this version of QuarkXPress, the application pre-
vents items on the locked layer from being selected or modified. This results
in the following changes from locking behavior in previous versions: 

• You cannot unlock a box that resides on a locked layer.

• You cannot create new items on a locked layer.

• If the active layer is locked, a red line displays through the pencil icon on the
Layers palette.
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A red line displays through the pencil icon when the active layer is locked.

• If an item in a group resides on a locked layer, none of the grouped items can
be selected with the Item tool e.

• When linked text boxes reside on different layers, each text box honors the
attributes of the layer it resides on. However, text on a locked layer can reflow
if you edit the contents of a preceding linked box on an unlocked layer.

• When you use the Item tool e or Content tool E to marquee multiple
items, QuarkXPress selects only items on unlocked layers. Similarly, when
you choose Edit & Select All, QuarkXPress selects only items on unlocked
layers. 

• When you press C+Option+Shift (Mac OS) or Ctrl+Alt+Shift (Windows) and
click to move through the stacking order of a page, QuarkXPress skips over
items on locked layers.

• The Lock Other Layers command has changed to the Lock All Layers
command. To lock items on all but the active layer, choose Lock All Layers
from the context menu and manually unlock the active layer. (This is a
change to “Locking Items on Layers” section of Chapter 15, “Layers,” in A
Guide to QuarkXPress: Using QuarkXPress.)

å When you save a project as a QuarkXPress 5.0 document, the locking behav-
ior reverts to version 5.0 functionality. 

EXCEPTIONS FOR ITEMS ON LOCKED LAYERS

In the following cases, you can modify items that reside on locked layers:

• The Spell Checking feature can select and correct text on locked layers.

• You can update pictures that reside on locked layers.

• When you modify appendable items such as style sheets or H&Js, the changes
can affect items on locked layers.
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• You can select indexed text on a locked layer when you double-click an
index entry in the Index palette.

• You can modify text on a locked layer using the Find/Change feature.

• You can select list text on a locked layer by double-clicking a list entry in the
Lists palette.

ENHANCEMENTS TO THE RELATIONSHIP BETWEEN LAYER

ATTRIBUTES AND ITEM ATTRIBUTES

This version of QuarkXPress contains a change in the behavior of items when
you lock or suppress output for the layer that they reside on. A layer’s Locked
and Suppress Output setting overrides, but doesn’t modify, the Lock and
Suppress Output settings for each individual item on that layer:

• When you check Suppress Output for a layer, none of the items on the layer
prints. When you uncheck Suppress Output for a layer, QuarkXPress honors
the Suppress setting (Item & Modify) for each item on that layer. 

• When you check Locked for a layer, all of the items on the layer are locked.
When you uncheck Locked, QuarkXPress honors the Lock setting (Item
menu) for each item on that layer. 

LAYERS PALETTE CONTEXT MENU

A new command, Select All Items on Layer, has been added to the Layers
palette context menu. Use this command to select all items on the selected
layer, within the active page or spread.

∫ This context menu command is unavailable if the selected layer is locked or
hidden.

NEW ATTRIBUTE INDICATORS IN LAYERS PALETTE

New text attributes help you easily identify layer attributes in the Layers
palette:

• If a layer name displays in italics, you have checked Suppress Output for that
layer.

• If a layer name displays in bold, you cannot delete the layer.
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When a layer name displays in italics, output of the layer is suppressed.

REORDERING LAYERS IN THE PALETTE

You no longer need to use a modifier key to change the order of layers in the
Layers palette. Instead, you simply click and drag the layer name to its new
position in the hierarchy. As you drag the layer name, a separator line dis-
plays to indicate where the layer will be placed when you release the mouse
button.

COPYING LAYERS FROM ONE LAYOUT TO ANOTHER

When you copy a layer from one layout to another, the layers will be stacked
in the destination layout with the same relationship to the Default layer that
they had in the source layout:

• Layers located above the Default layer are positioned as the topmost layers
in the destination layout, in the same order they were stacked in the source
layout.

• Layers located below the Default layer are positioned immediately below the
Default layer in the destination layout, in the same order they were stacked
in the source layout.

∫ You can drag a layer from one layout to another layout that resides in the
same project or to a layout in a different project.

å You can drag an item from one layout to another; when you do this, the
item’s layer also copies to the destination layout. 
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Chapter 7: Printing Enhancements —

Print Layouts Only

QuarkXPress 6.0 offers several improvements to its superior suite of printing fea-

tures. Use these enhancements to create smoother blends, manage color at the final

output device, or create a print layout space that can output composite as well as

separations. 

APPLYING SMOOTHSHADING

If a blend is too long, or the color or shade change in a blend is too dramatic for its
length, visible bands can print to a PostScript Level 1 or 2 device. PostScript Level 3,
on the other hand, gives you the ability to print blends without using separate bands
and static halftone values; this is called SmoothShading. Use QuarkXPress 6.0 with
a PostScript Level 3 device to print a smooth gradient from end to end, resulting in
substantial improvements in the quality of your blends. For information about using
blends, see “A Guide to QuarkXPress: Using QuarkXPress.”

To print a gradient using SmoothShading, all you need to do is print to a
PostScript Level 3 device. 

When you print a blend to a PostScript Level 1 or 2 device, the blend prints
using the technology from previous versions of QuarkXPress. In other words,
it prints using static halftone values that may result in visible bands on out-
put if the blend is too long or the gradient is too steep for the length of the
blend. For more information about banding, see “Understanding DPI and
LPI” in Chapter 23 of A Guide to QuarkXPress: Using QuarkXPress.

∫ When you apply As Is composite color to a blend, QuarkXPress applies the
source color space of “Color 1” to the blend. For information about As Is
color, see “Using As Is Composite Color” in this chapter.

å A blend within a QuarkXPress-generated EPS file prints to a PostScript Level 3
device using SmoothShading, even if the EPS file was created in a version of
QuarkXPress prior to 6.0.
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USING AS IS  COMPOSITE COLOR

When you want to color manage your printed output at the final output device,
QuarkXPress can help. The new As Is color feature lets you describe colored items
from their source color space when you output to a PostScript composite color device.
You can apply As Is color to printed projects, PDF files, and EPS files that you create
in QuarkXPress.

You can apply As Is composite color to print-optimized layout spaces. For informa-
tion about using layout spaces, see the “Layout Spaces” chapter in this document.

SPECIFYING AS IS COMPOSITE COLOR FOR PRINTING

To specify As Is composite color for a layout that you will print:

1 In a print-optimized layout space, choose File & Print to display the Print
dialog box.

2 Click the Setup tab and choose a PostScript composite color PPD from the
Printer Description pop-up menu.

3 Click the Output tab and choose As Is from the Print Colors pop-up menu.

4 Specify all the other print settings for the project, and then click Print.

After you have specified a composite color PPD, you can choose As Is from the Print Col-
ors pop-up menu in the Print dialog box Output tab.
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∫ As Is composite color is not applied when QuarkCMS™ is active.

When you apply As Is composite color to a blend, QuarkXPress applies the
source color space of “Color 1” to the blend.

å When you save a project that specifies As Is composite color output as a
QuarkXPress 5.0 document (File & Save As), settings default to composite
RGB color space in the Print dialog box, the Save Page as EPS dialog box,
and the PDF Options dialog box.

You can define As Is composite color in print styles for which you have cho-
sen a color PPD (Edit & Print Styles).

SPECIFYING AS IS COMPOSITE COLOR FOR PDF FILES

To specify As Is composite color for a PDF file:

1 In a print-optimized layout space, display the PDF Export Options
dialog box (QuarkXPress & Preferences & PDF & Options on Mac OS or
Edit & Preferences & PDF & Options on Windows) and click the Output
tab.

2 Choose a PostScript composite color PPD from the Printer Description pop-
up menu.

3 In the Color Output area, choose Composite from the Type pop-up menu. 

4 Choose As Is from the Print Colors pop-up menu.

5 Specify all the other PDF settings for the project, and then click OK.

6 Click OK to close the Preferences dialog box.

APPLYING AS IS COMPOSITE COLOR IN QUARKXPRESS EPS FILES

To apply As Is composite color to an EPS file that you create in QuarkXPress:

1 Choose File & Save Page as EPS to display the Save Page as EPS dialog box.

2 Choose Color from the Format pop-up menu.

3 Choose As Is from the Space pop-up menu.

4 Specify all the other settings for the EPS, and then click Save.
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Specify As Is settings in the Space pop-up menu.

∫ As Is composite colors are applied only when the Format pop-up menu is set
to Color.

SPECIFYING DEVICEN

The advent of recent technologies such as Portable Document Format have led to an
increase in the popularity of composite color output. In a workflow where you create
files for PDF and offset printing, you may find that you need to output a layout as
composite output as well as in separations. QuarkXPress now has DeviceN capabili-
ties that let you create a file with composite PostScript, and output it using a device
that supports In-RIP separations. Use DeviceN to output blends, multi-inks, col-
orized TIFFs, and other items as composite, while retaining their color separation
definitions. You can even apply DeviceN to EPS files that you create using the
QuarkXPress Save Page as EPS feature.
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DeviceN stores a list of each ink name and an alternative color description in a dic-
tionary. When you use DeviceN, QuarkXPress defines an item’s color by listing its
ink name and the ink percentages that combine to create the color. If you output the
item to separations, the ink percentages are used to print on the plates; if you output
the item as composite, the ink percentages and their colorants are combined in the
alternative color space to create a composite color. 

∫ If you are using QuarkCMS for color management, see the section “Using
DeviceN with QuarkCMS” in this chapter.

SPECIFYING DEVICEN FOR PRINTING

To specify DeviceN for composite printing:

1 In a print-optimized layout space, choose File & Print to display the Print
dialog box.

2 Click the Setup tab and choose the PPD for a color PostScript device from the
Printer Description pop-up menu.

3 Click the Output tab and choose DeviceN from the Print Colors pop-up
menu.

4 Specify all the other print settings for the project, and then click Print.

Choose DeviceN from the Print Colors pop-up menu if you want to use DeviceN for com-
posite color output.
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∫ If you specify DeviceN and then print to a PostScript Level 2 color device, the
project will output as CMYK.

If the project contains DCS pictures, a message will display to alert you that
separations will be restricted for those files. When the composite PostScript
descriptions are generated, composite descriptions of the DCS files will be
used.

When you save a project as a QuarkXPress 5.0 document (File & Save As),
the composite color DeviceN space is changed to Composite CMYK.

You can apply DeviceN composite color only to print-optimized layout
spaces. For information about using layout spaces, see the “Layout Spaces”
chapter in this document.

å If you use DeviceN regularly, you can save time by defining the DeviceN com-
posite color option in a Print Style (Edit & Print Styles).

SPECIFYING DEVICEN FOR PDF FILES

To specify DeviceN composite color for a PDF file:

1 In a print-optimized layout space, display the PDF Export Options
dialog box (QuarkXPress & Preferences & PDF & Options on Mac OS or
Edit & Preferences & PDF & Options on Windows) and click the Output
tab.

2 Choose a PostScript composite color PPD from the Printer Description pop-
up menu.

3 In the Color Output area, choose Composite from the Type pop-up menu. 

4 Choose DeviceN from the Print Colors pop-up menu.

5 Specify all the other PDF settings for the project, and then click OK.

6 Click OK to close the Preferences dialog box.

APPLYING DEVICEN IN QUARKXPRESS EPS FILES

To apply DeviceN capabilities to an EPS file that you create in QuarkXPress:

1 Choose File & Save Page as EPS to display the Save Page as EPS dialog box.

2 Choose Color, DCS, or DCS 2.0 from the Format pop-up menu.

3 Choose DeviceN from the Space pop-up menu.

4 Specify all the other settings for the EPS, and then click Save.
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Choose DeviceN settings from the Space pop-up menu.

USING COLOR MANAGEMENT WITH DEVICEN

To apply DeviceN settings when you use QuarkCMS, activate color manage-
ment in the Color Management Preferences dialog box (QuarkXPress &
Preferences & Color Management on Mac OS or Edit & Preferences &
Color Management on Windows).

When you specify the DeviceN composite color option for output and
QuarkCMS is active, QuarkXPress applies the ICC profile that you specify in the
Color Management Preferences dialog box Separation Output pop-up menu. 

∫ Although QuarkCMS preferences affect settings in the Print dialog box, they
do not affect the Save Page as EPS dialog box. The Composite and Separa-
tion pop-up menus default to None in the Save Page as EPS dialog box Pro-
file tab, regardless of the QuarkCMS preference settings. 

For more information about using QuarkCMS with QuarkXPress, see A Guide
to QuarkXPress: Using QuarkXPress.
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Chapter 8: Hyperlinks Enhancements

You can still create hyperlinks to URLs and anchors, but QuarkXPress 6.0 also lets

you create page-to-page hyperlinks within a print-optimized or Web optimized lay-

out. The Hyperlinks palette has also been updated to make it easier to use.

CREATING A HYPERLINK

1 Choose Edit & Hyperlinks. The Hyperlinks dialog box displays.

The Hyperlinks dialog box

2 Click New. The New Hyperlink dialog box displays.

The New Hyperlink dialog box

3 In the Name field, enter the name of the hyperlink. This name will only dis-
play in the Hyperlinks palette and the Hyperlinks dialog box; it will not be
visible in the printed or exported layout.

4 Choose the type of Hyperlink from the Type pop-up menu:

• Choose URL to specify a hyperlink to a URL, such as http://www.quark.com.
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• Choose Page to specify a hyperlink to another page within the layout.

• Choose Anchor to specify a hyperlink to an anchor; an anchor is a marker
attached to a specific place in a layout.

5 If you choose URL, the URL pop-up menu and field is available:

• Choose http:// to precede the URL with http://.

• Choose https:// to precede the URL with https://.

• Choose ftp:// to precede the URL with ftp://.

• Choose mailto: to create a hyperlink to an e-mail address. When you click
this hyperlink, your e-mail client or Web browser will launch and open a new
e-mail message with the specified e-mail address in the To field.

If you chose http://, https://, or ftp://, enter the URL.

If you chose mailto:, enter the e-mail address.

å Although URL and mailto: hyperlinks can be specified in a print-optimized
layout, they only work if the layout is exported as a PDF.

6 If you chose Page in the Type pop-up menu, the Page pop-up menu is avail-
able; choose a page in the selected layout.

7 If you chose Anchor in the Type pop-up menu, the Anchor pop-up menu is
available; choose an anchor location. 

8 Click OK. The New Hyperlink dialog box closes. Click Save in the Hyper-
links dialog box.

å You can use the Hyperlinks palette to create a hyperlink. To do so, choose
Window & Show Hyperlinks. Click the New Hyperlink button and
repeat steps 1–8 in “Creating a Hyperlink.”

You can also use the Hyperlinks context menu to create a new hyperlink. To
do so, select text or a picture, display the context menu and choose Hyper-
links & New. The New Hyperlink dialog box displays; repeat steps 1–8 in
“Creating a Hyperlink.”

EDITING A HYPERLINK

You may need to edit existing hyperlinks. For example, if a URL changes, you can
quickly enter the new URL in the hyperlink; the URL will be updated wherever that
hyperlink is applied. To edit a hyperlink:

1 Choose Edit & Hyperlinks. The Hyperlinks dialog box displays.
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2 In the Hyperlinks list, select the hyperlink you want to edit.

3 Click the Edit button. The Edit Hyperlink dialog box displays.

The Edit Hyperlink dialog box

4 If the hyperlink is associated with a URL, the Name and URL controls are
available. Enter a new Name in the Name field, or a new URL in the URL
field and pop-up menu.

If the hyperlink is associated with a page in the layout, the Name and Page
controls are available. Enter a new name in the Name field, or choose a new
page from the Page pop-up menu.

If the hyperlink is associated with an anchor, the Name and Anchor controls
are available. Enter a new name in the Name field, or choose a new anchor
destination from the Anchor pop-up menu. 

5 Click OK to save your changes.

DELETING A HYPERLINK

To delete a hyperlink:

1 Choose Edit & Hyperlinks. The Hyperlinks dialog box displays.

2 In the Hyperlinks list, select the hyperlink you want to delete.

3 Click the Delete button. An alert will display, asking you if you want to
delete this hyperlink. Click OK.

∫ If a hyperlink is applied to multiple items, deleting a hyperlink using the
Hyperlinks dialog box or the Hyperlinks palette will delete the hyperlink
from all items. If you only want to remove a hyperlink from one instance,
select the instance and display the context menu; choose Hyperlinks &
Remove. The hyperlink will be removed from the instance but will still be
defined in the project.
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å To delete a hyperlink using the Hyperlinks palette, choose Window & Show
Hyperlinks. In the Hyperlinks palette, select the hyperlink you want to
delete and click the Delete button .

APPENDING HYPERLINKS

You can use the Append feature to append hyperlinks from other projects. 
To do so:

1 Choose Edit & Hyperlinks. The Hyperlinks dialog box displays.

2 Click the Append button.

3 Use the Append dialog box to navigate to the project containing the hyper-
links you want to append and click OK.

4 In the Available list, select the hyperlinks you want to append.

5 Click the Add arrow to add the hyperlinks to the Include list. Or, click
Include All to append all the hyperlinks in the project.

6 Click OK; the hyperlinks will be added to the project.

∫ You can only append hyperlinks associated with a URL; hyperlinks associated
with anchors or pages are not available in the Append dialog box.

å For information on handling append conflicts, see Chapter 3, “File Menu,” in
A Guide to QuarkXPress 5.0.

USING THE HYPERLINKS PALETTE

You can specify the way the Hyperlinks palette displays hyperlinks and anchors.
To do so:

1 In the Show area, click an icon:

• Click the URLs button to display hyperlinks to URLs.

• Click the Anchors button to display hyperlinks associated with anchors.

• Click the Pages button 1 to display hyperlinks associated with pages.
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The Hyperlinks palette

2 Clicking an icon hides or shows the hyperlinks associated with it. For exam-
ple, if no hyperlinks associated with URLs are displayed, clicking URLs dis-
plays them in the Hyperlinks palette. If hyperlinks associated with URLs are
displayed, clicking URLs hides them.

3 In the Show pop-up menu, choose an option:

• Choosing Name displays the names of the hyperlinks. These are the names
you assigned in the Name field of the New Hyperlink dialog box.

• Choosing Link displays the link the hyperlink is associated with, such as
“http://www.quark.com.”

APPLYING HYPERLINKS TO TEXT

To apply a hyperlink to text:

1 Choose Window & Show Hyperlinks to display the Hyperlinks palette.

2 Select the text you want to apply the hyperlink to.

3 Click a hyperlink in the Hyperlinks palette.

APPLYING HYPERLINKS TO PICTURES

To apply a hyperlink to a picture:

1 Choose Window & Show Hyperlinks to display the Hyperlinks palette.

2 Select the picture you want to apply the hyperlink to.

3 Click a hyperlink in the Hyperlinks palette.
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Chapter 9: Web Features Enhancements

CASCADING MENUS

The Cascading Menu feature lets you create Web-optimized layouts that provide
great user interface and visual interest. Using cascading menus lets you simplify
your design by “hiding” menu items until the user moves the mouse pointer over a
specific item.

CREATING CASCADING MENUS

Before you can apply a cascading menu, you must create it. To do so:

1 Choose Edit & Cascading Menus. The Cascading Menus dialog box 
displays.

The Edit Cascading Menu dialog box

2 Click New; the Edit Cascading Menu dialog box displays.

3 In the Menu Name field, enter a name for the cascading menu.

4 In the Menu Properties tab, choose a color for the cascading menu from the
Background Color pop-up menu. Choose a style sheet for the cascading
menu from the Style Sheet pop-up menu.

5 Enter a value in the Text Inset field to specify how far from the edge of the
cascading menu box the text of the menu will display.

6 In the Menu Orientation area, click Horizontal or Vertical to specify which
direction the menu should read.

7 In the Box area, specify a width and height for the entire cascading menu.
The Auto value is calculated using the character count of the name of the
menu item or submenu item and the font size.
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8 In the Border area, specify a line width in the Line field and a color for the
line in the Color pop-up menu. This line and color will be applied to the
entire cascading menu box.

9 In the Separator area, specify a line width in the Line field and a color for
the separators in the Color pop-up menu. This line width and color will be
applied to the separators between menu items.

10 In the Opening Animation area, choose an option from the Direction pop-
up menu:

• Choosing Top to Bottom displays the menu from top to bottom.

• Choosing Bottom to Top displays the menu from the bottom to the top.

• Choosing Left to Right displays the menu from left to right.

• Choosing Right to Left displays the menu from right to left. 

• Choosing None specifies that the menu displays with no animation.

11 If you chose an option other than None from the Opening Animation pop-
up menu, the Speed field is available. Enter a value between 0 and 10,000;
speed is measured in milliseconds. Entering a value of 0 specifies that there is
no delay between the time the cascading menu is invoked and when it dis-
plays.

12 In the Offset fields, enter a value in the X and Y fields to specify how far the
menu items should be offset from the menu.

13 The Menu Items tab allows you to specify the menu and submenu items. In
the Menu Structure area, choose Menu Item from the New pop-up button to
create a new menu item.

14 In the Menu Item Name field, enter a name for the menu item.

15 To specify a hyperlink for the menu item, choose a hyperlink from the
Hyperlink pop-up menu, or enter a hyperlink in the Hyperlink field. Only
hyperlinks associated with URLs display in the Hyperlink pop-up menu.

16 To specify a submenu item, select the menu in the Menu Structure list, and
choose Submenu Item from the New pop-up button.

17 In the Submenu Item Name field, enter a name for the submenu item.

18 To specify a hyperlink for the submenu item, choose a hyperlink from the
Hyperlink pop-up menu, or enter a hyperlink in the Hyperlink field. Only
hyperlinks associated with URLs display in the Hyperlink pop-up menu.

19 Continue adding menu items and submenu items until you are satisfied with
the menu structure. 
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å Submenu items will always be added under the selected menu item and will
display indented in the Menu Structure list.

20 In the Menu Item Mouseover area, choose a color for the menu item from
the Font pop-up menu and a color for the background from the Background
pop-up menu. When the mouse pointer is moved over the menu item, the
menu item will display using these colors.

21 In the Submenu Item mouseover area, choose a color for the submenu item
from the Font pop-up menu and a color for the background from the Back-
ground pop-up menu. When the mouse pointer is moved over the submenu
item, the submenu item will display using these colors.

22 Click OK; the New Cascading Menu dialog box closes. Click Save in the 
Cascading Menu dialog box.

APPLYING A CASCADING MENU TO A BOX

Once you have specified a cascading menu, you can apply it to any item that
has been specified to export as a graphic (Item & Modify & Export & Con-
vert to Graphic). To do so:

1 Select the item.

2 Choose Item & Cascading Menu, or display the context menu and choose
Cascading Menu. In the Cascading Menu submenu, choose the cascading
menu you want to apply to the box.

3 Save the layout. Choose Page & Preview HTML to export and preview the
HTML.

4 In your Web browser, verify that the cascading menu displays as you want 
it to. 

EDITING A CASCADING MENU

To edit a cascading menu:

1 Choose Edit & Cascading Menus.

2 In the Cascading Menus dialog box, select the cascading menu you wish to
edit and click Edit.

3 In the Edit Cascading Menu dialog box, make the changes. Click OK when
you are done. The Edit Cascading Menu dialog box closes. Click Save in the
Cascading Menu dialog box.

APPENDING CASCADING MENUS

You can append cascading menus from other Web-optimized layouts. This is
useful when you have several menus that are the same throughout a variety
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of layouts, such as a menu that provides contact information and options. To
append cascading menus:

1 Choose Edit & Cascading Menus.

2 In the Cascading Menu dialog box, click Append. The Append From dialog
box displays. 

3 Navigate to the project that contains the cascading menus you want to
append and click OK.

4 In the Append dialog box, select a cascading menu in the Available list and
click the Add arrow to move the cascading menu to the Include list. Or, click
Include All to append all the cascading menus in the layout.

5 Click OK.

DELETING CASCADING MENUS

To delete a cascading menu from a layout:

1 Choose Edit & Cascading Menus.

2 In the Cascading Menus dialog box, select the cascading menu you want to
delete and click Delete.

3 If the cascading menu is applied to a box in the layout, an alert will display,
asking you if you wish to delete the menu. Click OK to delete the cascading
menu or Cancel to stop the deletion.

DUPLICATING CASCADING MENUS

The ability to duplicate a cascading menu is useful when you have specified
complicated menus that you need to use elsewhere, but with slightly differ-
ent information. For example, if you were creating a multilingual layout, and
wanted to use U.S. English in one area of the layout but international English
in another area, duplicating a cascading menu would save you the trouble of
recreating the entire menu. To duplicate a cascading menu:

1 Choose Edit & Cascading Menu.

2 In the Cascading Menu dialog box, select the cascading menu you want to
duplicate and click Duplicate.

3 A new cascading menu will be created; its contents will be the same as the
original menu, but its name will be different. For example, if the original
menu was named “Contacting Us,” the new menu will be named “Copy of
Contacting Us.”

4 Select the duplicated cascading menu and click Edit; use the Edit Cascading
Menu dialog box to make changes to the duplicated menu. When you are
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finished making changes, click OK; the Edit Cascading Menu dialog box
closes. Click Save in the Cascading Menus dialog box.

REMOVING A CASCADING MENU FROM A BOX

To remove a cascading menu from a box:

1 Select the box and choose Item & Cascading Menu & Remove Cascading
Menu, or display the context menu and choose Cascading Menu & Remove
Cascading Menu.

2 The cascading menu is removed from the box; the contents of the box
remain intact.

∫ Removing a cascading menu from a box does not delete it from the project;
to delete a cascading menu from a project, follow the steps in “Deleting a
Cascading Menu.”

ROLLOVERS

You can still create basic rollovers in QuarkXPress 6.0, but the two-position
rollovers feature of QuarkXPress 6.0 allows you to add greater visual interest to your
Web layouts.

CREATING A BASIC ROLLOVER

A basic rollover is the same as a rollover in QuarkXPress 5.x. In a basic
rollover, both the default content and the rollover content are displayed in
the same box. The method of creating and using a basic rollover is the same
as it was in QuarkXPress 5.x; however, the Create Rollover dialog box has
been enhanced to use the same controls as the Get Picture dialog box, so
that you can see previews of the images you are importing.

∫ When creating a rollover in a Web layout, you can only select a GIF, JPEG, or
PNG file for the rollover image. The default image may be of another file
type, but should be changed (in the Modify dialog box) to export as a GIF,
JPEG, or PNG.

å You can also create a rollover for any text box for which you have checked
Convert to Graphic on Export in the Modify dialog box.

CREATING A TWO-POSITION ROLLOVER

You can now create a two-position rollover. In a two-position rollover, the
object you move your mouse pointer over is separate from the object that dis-
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plays the rollover. This means you can make text or picture boxes in different
areas of the page rollovers. To create a two-position rollover:

1 Create a text or picture box. This is the origin box — the box that the mouse
pointer will be moved over to invoke the rollover.

2 If the box is a text box, choose Item & Modify and check Convert to
Graphic on Export.

3 Import a picture or text into the box.

4 Create another text or picture box. This is the target box — the box that will
change its contents when the mouse pointer is moved over the origin box.

5 If the box is a text box, choose Item & Modify and check Convert to
Graphic on Export.

6 Import a picture or text into the box. This is the default content for the box.
The default content displays whenever the rollover effect is not active.

7 With the target box selected, display the context menu and choose
2-Position Rollovers & Create 2-Position Target, or choose Item &
Rollovers & Create 2-Position Target.

Context menu for a two-position rollover

8 Import a new picture or text into the target box; this content displays when
the rollover is active.

9 In the Web Tools palette, select the 2-Position Rollover Linking tool.

10 Click the origin box, then click the target box. This links the origin and target
boxes so that when the mouse pointer is moved over the origin box, the con-
tent of the target box displays.

11 Save the layout. Choose Page & Preview HTML to export and preview 
the HTML.

12 In your Web browser, verify that the rollover displays as you want it to. 
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ADDING MULTIPLE TARGETS TO A TWO-POSITION ROLLOVER

You can have more than two targets in the same rollover box; this is useful if
you want the target box to display a variety of images.

To add multiple target areas to a two-position rollover:

1 Repeat steps 1–9 in "Creating a Two-Position Rollover,” creating the same
number of origin boxes as target boxes.

2 Repeat steps 8–9 in “Creating a Two-Position Rollover” for each additional
target you want to create.

3 Once all the targets are created, display the context menu and choose 
2-Position Rollovers & Show, or choose Item & 2-Position Rollovers &
Show. The Show submenu displays a list of all the target content (for exam-
ple, “Picture 1,” “Sunset,” and so on).

4 In the Show submenu, choose the target you want to link the rollover to.

5 In the Web Tools palette, select the 2-Position Rollover Linking tool.

6 Click the origin box, then click the target box. This links the origin and target
boxes so that when the mouse pointer is moved over the origin box, the con-
tent of the target box displays.

7 Repeat steps 3–6 for each additional origin and target box.

8 Save the layout. Choose Page & Preview HTML to export and preview 
the HTML.

9 In your Web browser, verify that the rollover displays as you want it to. 

LINKING A BASIC ROLLOVER AND A TWO-POSITION ROLLOVER

You can combine basic rollovers with two-position rollovers. To do so:

1 Create a basic rollover using a raster text box or a picture box.

2 Repeat steps 4–13 in "Creating a Two-Position Rollover," using the basic
rollover as the origin box.

∫ You cannot link two-position rollovers to two-position rollovers.

REMOVING TARGETS FROM TWO-POSITION ROLLOVERS

To remove the target from a two-position rollover:

1 Select the box containing the two-position rollover.

2 Display the context menu and choose 2-Position Rollover & Remove 2-
Position Rollover, or choose Item & 2-Position Rollover & Remove 2-Posi-
tion Rollover.
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REMOVING A TARGET FROM A TWO-POSITION ROLLOVER BOX

To remove only a single target from a two-position rollover box:

1 Select the box containing the two-position rollover.

2 Display the context menu and choose 2-Position Rollover & Remove Tar-
get, or choose Item & 2-Position Rollover & Remove Target.

3 In the Remove Target submenu, select the image you want to remove.

UNLINKING A TWO-POSITION ROLLOVER

To unlink a two-position rollover:

1 In the Web Tools palette, select the 2-Position Rollover Unlinking tool.

2 Click the origin box, then the target box, to be unlinked; this removes the
link between the origin and target, but does not remove the content from 
the boxes.

FORM CONTROLS

QuarkXPress 6.0 provides several enhancements to form controls.

CHANGING THE CONTENT OF A BOX

You can easily change the content type of an existing box to Form. To do so:

1 Select the box.

2 Choose Item & Content & Form. The box is now a form box.

å You can also display the context menu and choose Content & Form.

SPECIFYING A NEW MENU

The New button in the Form tab of the Modify dialog box has been changed
to the Menu pop-up menu, from which you can choose New or an existing
menu. The Menu pop-up menu is only available for pop-up menu and list
box controls. Choosing New from the Menu pop-up menu displays the Edit
Menu dialog box; for information about this dialog box, see Chapter 23,
“Form Controls,” in A Guide to QuarkXPress: Using QuarkXPress.

DOWNSAVING FORMS

When a QuarkXPress project is saved in QuarkXPress 5.0 format, any
form box that resides in a table cell will be converted to a table cell with a
content of None.
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OTHER ENHANCEMENTS TO FORM CONTROLS

• You can place a form on a layer.

• You can create form boxes in table cells.

• You can apply a color to a form box using the Colors palette or the Color
pop-up menu in the Box tab of the Modify dialog box. However, you cannot
specify a blend.

• Form boxes cannot overlap one another.

• You can place QuarkXPress items in a form box or form controls.

PREVIEWING AND EXPORTING HTML

To make preview and export more convenient, HTML Preview and HTML Export
features have been added to the context menu.

PREVIEWING HTML

1 In a Web-optimized layout, display the context menu.

2 To preview the contents of your Web-optimized layout, choose
Preview HTML.

Context menu for Preview HTML

3 In the Preview HTML submenu, choose the Web browser you want to use to
display the pages. (Web browsers are specified in the Preferences dialog box.)

4 If you previously checked Launch Browser in the HTML Export dialog box,
your Web browser will launch and display the Web-optimized layout as an
HTML document.

å You can also access the Preview HTML and Export HTML commands by dis-
playing the context menu when a page in the Layout palette is selected, or
from the Page menu.
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EXPORTING HTML

1 In a Web-optimized layout, display the context menu.

2 To export the contents of your Web-optimized layout, choose Export &
HTML.

3 Specify the location of the exported HTML in the Export HTML dialog box.

4 If you checked Launch Browser in the HTML Export dialog box, your Web
browser will launch and display the Web-optimized layout as an HTML
document.

OTHER ENHANCEMENTS TO WEB TOOLS

CHANGING A BROWSER NAME IN THE PREFERENCES DIALOG BOX

You can now change the name of a browser in the Preferences dialog box. To
do so:

1 Choose QuarkXPress & Preferences (Mac OS) or Edit & Preferences
(Windows).

2 In the Browsers pane of the Preferences dialog box, select the browser you
want to rename and click Edit.

3 In the Display Name field of the Edit Browser dialog box, enter a new name
for the selected Web browser and click OK.

∫ Changing the browser name only changes the way the name displays in
QuarkXPress menus; it does not change the name of the application itself.

SPECIFYING CSS FONT FAMILIES

Creating font families for cascading style sheets gives you greater control over
your design. By specifying a font family, you can determine what fonts will be
used to display your Web page if the original font is not available to the user.

To specify a font family:

1 Choose Edit & CSS Font Families.

2 In the CSS Font Families dialog box, click New; the Edit Font Family dialog
box displays.
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The Edit CSS Font Families dialog box

3 Select the font you want to create a font family for; the name of the font dis-
plays in the Name area.

4 Choose a font from the Generic Font pop-up menu; the type of font you
specify in the Generic Font pop-up menu will be used if none of the fonts
specified in the font family are available to the browser displaying the Web
page.

• Choosing Serif specifies that the generic font is any standard serif font, such
as Times.

• Choosing Sans Serif specifies that the generic font is any standard sans serif
font, such as Arial.

• Choosing Cursive specifies that the generic font is any standard script font,
such as Freestyle Script.

• Choosing Fantasy specifies that the generic font is any special display font,
such as Western.

• Choosing Monospace specifies that the generic font is any standard mono-
space font, such as Courier.

∫ You must specify a generic font.

5 To add fonts to the font family, click a font in the Available Fonts list and
click the Add arrow to move the font to the Fonts in Font Family list. 

6 As fonts are added, they are assigned a level; levels are assigned in descending
order. A level 1 font is the first font the browser will search for when the page
is displayed; a level 2 font is the second font the browser will look for (if the
first font cannot be found); and so on. You can enter up to 29 fonts in the
Font Family list.

7 To change the level of a font, select the font in the Font Family list and click
Move Up or Move Down.
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8 To remove a font from the Font Family list, select the font in the Font Fam-
ily list and click the Remove arrow.

9 Click OK. In the CSS Font Families dialog box, click Save.

SPECIFYING ADDITIONAL IMAGE EXPORT FOLDERS

You can now specify additional export folders for pictures and raster text
boxes in Web layouts. To do so:

1 Select the text or picture box and choose Item & Modify, or display the con-
text menu and choose Modify.

2 If you have selected a text box, check Convert Image to Graphic on Export.

3 In the Export tab, enter a name for the export folder in the Export To field.
If multiple folders have been specified, the Export To field changes to the
Export To pop-up menu and displays up to seven folders.

The Export tab

4 Click OK. When the Web-optimized layout is exported, a folder with the
name you specified will be created and the selected image will be exported to
that folder.

∫ All folders are created at the root level of the export directory.

You can multiple-select pictures and raster text boxes, then specify an export
directory in the Export tab of the Modify dialog box.
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Chapter 10: Other Changes in

QuarkXPress 6.0

CHANGES TO QUARKXPRESS MENUS

New features and changes in operating system support have led to changes in some
QuarkXPress menus and their commands. A new menu, Layout, is now part of the
QuarkXPress interface on Mac OS and Windows. On Mac OS, you can take advan-
tage of the new QuarkXPress and Window menus. Additionally, you’ll notice that
some commands have moved from the View menu to the Window menu. 

You may notice menu changes besides those detailed in this section. For information
about other menu changes, see the information about the individual feature for the
menu command.

USING THE LAYOUT MENU

The Layout menu contains the commands that let you manipulate layout
spaces. Use this menu to create, edit, delete, or duplicate a layout space, and
to maneuver between layout spaces within a project. 

å For more information about layout spaces, see Chapter 1, “Layout Spaces.”

USING THE QUARKXPRESS MENU — MAC OS ONLY

The QuarkXPress menu is the first menu on the left. This menu contains the
same commands that you find in the application menu for other OS X appli-
cations. Use this menu to display information about QuarkXPress, to hide or
show QuarkXPress and other applications, to access preferences, and to quit
QuarkXPress.

The QuarkXPress menu contains the same options as other OS X applications.
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DISPLAYING INFORMATION ABOUT QUARKXPRESS

The About QuarkXPress command lets you display the splash screen for
QuarkXPress and the QuarkXPress Environment window. The QuarkXPress
Environment window displays information specific to the active
QuarkXPress application, including a list of active QuarkXTensions software
and third-party XTensions software. 

• To display the QuarkXPress splash screen, choose QuarkXPress & About
QuarkXPress. 

• To display the QuarkXPress Environment window, press Option as you
choose QuarkXPress & About QuarkXPress. 

ACCESSING PREFERENCES

In earlier versions of QuarkXPress, you accessed preference settings through
the Edit menu. The Preferences command is now located in the
QuarkXPress menu. To access the Preferences dialog box, choose
QuarkXPress & Preferences.

Use the Preferences submenu to access preference commands on Mac OS.

USING SERVICES

To use an application service, choose QuarkXPress & Services, and choose
the appropriate service from the submenu. For information about services,
see the documentation provided with Mac OS X.

SHOWING AND HIDING APPLICATIONS

The QuarkXPress menu Show and Hide commands let you specify which
applications display on your screen:

• Choose QuarkXPress & Show QuarkXPress to display QuarkXPress and the
active project. Choose QuarkXPress & Hide QuarkXPress to remove
QuarkXPress from the screen without quitting the application.

• Choose QuarkXPress & Show Others to display all other applications that
are running. Choose QuarkXPress & Hide Others to remove all other appli-
cations from the screen without quitting them.

• Choose Show All to display all applications that are running.
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QUITTING QUARKXPRESS

In earlier versions of QuarkXPress, you accessed the Quit command in the
File menu. The Quit command is now located in the QuarkXPress menu.

VIEW MENU CHANGES

The Show and Hide commands for all QuarkXPress and QuarkXTensions
software palettes have been removed from the View menu. These commands
are now located in the Window menu. Use the Show command to display a
given palette; use the Hide command to close a given palette.

∫ While the Show and Hide commands for palettes are now located in the Win-
dow menu, the Show and Hide commands for project features — guides, base-
line grid, rulers, invisibles, and visual indicators — remain in the View menu.

WINDOW MENU CHANGES — WINDOWS ONLY

The Show and Hide commands for all QuarkXPress and QuarkXTensions
palettes have been moved to the second section of the Window menu. Use
the Show command to display a given palette; use the Hide command to
close a given palette.

USING THE WINDOW MENU ON MAC OS — MAC OS ONLY

The Window menu has been added to QuarkXPress for Mac OS, and its func-
tionality parallels the behavior of the Window menu in QuarkXPress for
Windows. Use this menu to specify how open projects display on-screen, and
to specify which palettes display. 
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Use the Window menu to specify how projects display on-screen and to open or close a
palette.

The first section of the Window menu lets you specify how multiple open
projects display on the monitor:

• Use the Bring All to Front command to bring forward all open QuarkXPress
windows, while maintaining their current locations, sizes, and stacking order
on the screen.

• Use the Tile command to resize project windows so equal portions of all open
projects display on-screen. The active project always displays in the upper left
part of the main monitor; the most recently active projects display from left
to right and top to bottom. If Tile to Multiple Monitors is checked in the
Display pane of the Preferences dialog box (QuarkXPress & Preferences),
you can use more than one monitor for tiling projects. The Tile command
performs the same function as the Tile Documents command chosen from
the View menu (View & Windows & Tile Documents) in previous versions
of QuarkXPress for Mac OS.

• When you choose Stack, QuarkXPress layers multiple open projects so a
small portion of each project’s menu bar displays. The Stack command per-
forms the same function as the Stack Documents command chosen from the
View menu (View & Windows & Stack Documents) in previous versions of
QuarkXPress for Mac OS.
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The Show and Hide commands for all QuarkXPress and QuarkXTensions
palettes are now located in the second section of the Window menu. Use the
Show command to display a given palette; use the Hide command to close a
given palette.

å While the Show and Hide commands for palettes are now located in the
Window menu, the Show and Hide commands for project features —
guides, baseline grid, rulers, invisibles, and visual indicators — remain in
the View menu.

The third section of the Window menu displays a list of all open projects.
Use this menu to choose which project is active (in the front). Projects con-
taining unsaved changes display a bullet next to their names.

FULL-RESOLUTION PREVIEW

QuarkXPress 6.0 can display pictures on-screen using the picture file’s full resolu-
tion. This allows you to scale or magnify the image with minimal pixelation (as
long as the source image has a high enough resolution to accommodate the magnifi-
cation).

APPLYING FULL RESOLUTION PREVIEW TO SELECTED IMAGES

To apply the Full-Resolution Preview feature to selected images:

1 Select the picture. (You can also multiple-select pictures.)

2 Choose Item & Preview Resolution & Full Resolution. When Full Resolu-
tion is checked, the full resolution of the image is used to display the image. 
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To display selected pictures at full resolution, choose Item & Preview Resolution & Full
Resolution.

∫ If the image is listed as Missing or Modified in the Picture tab of the Usage
dialog box, an alert will display, allowing you to update the path to 
the pictures.

Full Resolution Preview will not be applied to GIF files, PICT files, or WMF files.

APPLYING FULL RESOLUTION PREVIEW WHEN IMPORTING PICTURES

To apply the Full Resolution Preview feature to a picture at import:

1 Select a picture box and choose File & Get Picture.

2 In the Get Picture dialog box, click the Full Resolution Preview tab.

3 In the Full Resolution Preview tab, check Create Full-Resolution Preview. 

4 Click OK to import the picture with a full-resolution preview.
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DISPLAYING FULL RESOLUTION PREVIEWS IN A LAYOUT

To display full-resolution previews for the entire layout:

1 Choose View & Show Full Res Previews.

2 Any pictures that are set to display at full resolution (Item & Preview Reso-
lution & Full Resolution) will do so.

SETTING PREFERENCES FOR FULL RESOLUTION PREVIEW

When Show Full Res Previews is on, the preview files for any pictures
imported from a network volume will be cached in a folder named “Preview
Cache.” To change the location of this cache folder, and to change other
preferences for Full Resolution Preview:

1 Choose QuarkXPress & Preferences (Mac OS) or Edit & Preferences
(Windows). 

Change the way Full Resolution Preview works by editing the settings in the Full Res
Preview pane of the Preferences dialog box.

2 In the Full Res Preview pane, click Other Folder in the Preview cache loca-
tion area. When Other Folder is selected, the Browse button is available;
navigate to another folder and click OK.
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3 To change the maximum size of the folder containing the preview cache files,
enter a value in the Maximum Cache Folder Size field. The default value is
100MB.

∫ If you import pictures from a network volume and do not have enough disk
space to create the full resolution preview, an alert will display and the image
will display at low resolution.

If the resolution of any selected pictures is lower than 91 dpi, an alert will dis-
play and the image will display at low resolution.

4 To specify when pictures are displayed at full resolution, click a radio button
in the Display Full Resolution Preview For area:

• When All Full Resolution Previews is selected, all pictures in the project that
are set to display at full resolution will be displayed at full resolution. All Full
Resolution Previews is the default setting.

• When Selected Pictures is checked, pictures set to display at full resolution
will only do so when they are selected. When a picture is not selected, it will
display a low-resolution preview.

5 To turn off Full Resolution Preview when opening a project, check Disable
Full Resolution Previews on Open. When Disable Full Resolution Previews
on Open is checked, projects opened in QuarkXPress do not display images
at full resolution when opening the project. If Full Resolution Preview has
been specified for selected pictures, the pictures retain that setting; however,
they do not display at full resolution unless you chose View & Show Full
Resolution. When Disable Full Resolution Previews on Open is unchecked,
pictures that were set to display at full resolution will display at full resolu-
tion when the project is opened (if View & Show Full Resolution is
selected).

å The Disable Full Resolution Previews on Open check box is useful if you
have a project containing many graphics that are set to display at full resolu-
tion; by checking Disable Full Resolution Previews on Open, you can sig-
nificantly decrease the amount of time it takes to open a project.

To turn Full Resolution Preview off while you are working in the layout,
choose View & Hide Full Res Preview.

PRINTING WITH FULL RESOLUTION PREVIEW

If you specify Low Resolution in the Print dialog box (Options tab & Out-
put pop-up menu), all pictures in the layout, including any pictures set to
display at full resolution, will print at low resolution.
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If you print a raster EPS file to a non-PostScript device, and the picture is set
to display at full resolution, the full-resolution preview will print.

SUPPRESSING ITEM OUTPUT

The Suppress Output check box replaces the Suppress Printout check box in
the Attributes dialog box (Layers palette), the Modify dialog box (Item &
Modify), and the Layer preferences (QuarkXPress & Preferences & Layers
pane on Mac OS or Edit & Preferences & Layers pane on Windows).

The Suppress Picture Output check box replaces the Suppress Picture Print-
out check box in the Modify dialog box Picture tab (Item menu).

ENTERING ZAPF DINGBATS OR SYMBOL FONT FOR A SINGLE

CHARACTER — MAC OS ONLY

The keyboard command to enter a single character in the Zapf Dingbats font
has been changed to C+Option+Z.

The keyboard command to enter a single character in the Symbol font has
been changed to C+Option+Q.

OTHER CHANGES

Following is feature information that changed in QuarkXPress 5.x after “A Guide to
QuarkXPress: Using QuarkXPress” was completed. These changes are also relevant
to QuarkXPress 6.0.

QUARKCMS QUARKXTENSIONS SOFTWARE

Windows only: If you are using QuarkXTensions software, QuarkCMS, the
Color Management pop-up menu in the Color Management Preferences
dialog box has been changed to the Color Management Active check box;
activate QuarkCMS by checking Color Management Active. Because of this
change, QuarkCMS for Windows will use the Kodak CMM (Color Manage-
ment Module); you will not be able to choose a different CMM. (This is a
change to “Setting Color Management Preferences” and “Changing Profiles
Before Printing” in the “Using Color Management” section of Chapter 12,
“Color,” in A Guide to QuarkXPress: Using QuarkXPress.)
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CHANGES TO QUARKXPRESS PASSPORT

ENHANCED SPELL CHECKING FEATURE

An additional spelling dictionary is available for Dutch, French, German, Ital-
ian, Reformed German, and Swiss German in QuarkXPress Passport™. When
you check spelling for these languages, you can now choose whether you
want to use the new dictionary, or the original dictionary from QuarkXPress
or QuarkXPress Passport 5.0. 

QuarkXPress automatically uses the new dictionary to check spelling when
AltSpellchecker QuarkXTensions software is loaded. AltSpellchecker is loaded
by default when you install QuarkXPress. 

To use the original QuarkXPress dictionary to check spelling, disable
AltSpellchecker either using the XTensions Manager (Utilities menu), or by
removing it from the “XTension” folder before launching QuarkXPress.

ENHANCED HYPHENATION FEATURE

An additional hyphenation option called Extended 2.0 is available for
Dutch, French, German, Italian, Reformed German, and Swiss German. To
change the hyphenation option, choose Edit & Preferences & Paragraph
pane, and then choose the option in the Hyphenation area Method pop-up
menu. Extended 2.0 is the default option.

USING REFORMED GERMAN

For users running German operating systems, the default paragraph language
is German, so existing layouts do not reflow. However, if you want to use
Reformed German as your default paragraph language, regardless of your Pro-
gram Language setting (Edit menu), follow these steps.

1 Close all open projects.

2 Choose Edit & Style Sheets.

3 Select the Normal paragraph style sheet and click Edit.

4 In the Formats tab, set the Language pop-up menu to German, Reformed.

5 Click OK and then click Save.

If your program language is Swiss German, continue to set your program lan-
guage to Swiss German (Edit & Program Language) if you want to use
Swiss German keyboard commands. This will still allow you to set the para-
graph language to Reformed German so you can use the Reformed German
hyphenation rules and dictionary.
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